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Abstract 

A new hospital in United Arab Emirates (UAE) plans to adopt health information 

technology (HIT) and become fully digitalized once operational. The hospital has 

identified a need to assess basic computer literacy of new employees prior to offering 

them training on various HIT applications. Lack of research in identifying an accurate 

assessment method for basic computer literacy among health care professionals led to this 

explanatory correlational research study, which compared self-assessment scores and a 

simulated actual computer skills test to find an appropriate tool for assessing computer 

literacy. The theoretical framework of the study was based on constructivist learning 

theory and self-efficacy theory. Two sets of data from 182 hospital employees were 

collected and analyzed. A t test revealed that scores of self-assessment were significantly 

higher than they were on the actual test, which indicated that hospital employees tend to 

score higher on self-assessment when compared to actual skills test. A Pearson product 

moment correlation revealed a statistically weak correlation between the scores, which 

implied that self-assessment scores were not a reliable indicator of how an individual 

would perform on the actual test. An actual skill test was found to be the more reliable 

tool to assess basic computer skills when compared to self-assessment test. The findings 

of the study also identified areas where employees at the local hospital lacked basic 

computer skills, which led to the development of the project to fill these gaps by 

providing training on basic computer skills prior to them getting trained on various HIT 

applications. The findings of the study will be useful for hospitals in UAE who are in the 

process of adopting HIT and for health information educators to design appropriate 

training curricula based on assessment of basic computer literacy.
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Section 1: The Problem 

Definition of the Problem 

Computers and information technology (IT) have become ubiquitous in the health 

care industry. Hospitals across the United Arab Emirates (UAE) are increasingly 

adopting IT applications for maintaining health information systems (HIS). A new 

hospital in UAE, which at the time of the study was in the project phase, was planning to 

have a fully IT-integrated hospital right from the first day of operations. The hospital 

anticipated they would be fully operational by early second quarter of 2015 and would 

have more than 72 IT applications related to HIS once operational. The employees, the 

majority of whom are clinical staff, are diverse in terms of nationalities, culture, 

educational background, age, gender, and computer skills. The challenge was to ensure 

that the employees were proficient and competent in using the HIS-related IT 

applications upon beginning work. For this to happen the employees needed to be trained 

on the use of these IT applications, and the training would have to be tailored to meet the 

existing knowledge and skill set of the employees. For example, employees with limited 

skills in using a computer will need training that is extensive in the basics first, and then 

in the specific HIS applications, while others may need training only for the specific HIS 

applications. 

While analyzing IT applications training, the hospital’s committee for activation 

and training (CAT), which was set up to analyze, plan, and organize organization-wide 

training requirements emphasized that to ensure the employees receive appropriate 

training within the specified timeframe, they will first need to be assessed for their basic 
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computer literacy. A lack of assessment of basic computer skills has been identified as 

one of the barriers in successful implementation of electronic medical record (EMR) 

technology across the world. As the hospital would have employees from diverse 

educational backgrounds and work experience, it was imperative that an accurate 

assessment be conducted to measure the level of computer literacy among these 

employees. The assessment of computer literacy could either be accomplished as a self- 

assessment or by administering a practical assessment. The method used for assessment 

should be feasible in terms of time consumed and accuracy of the results. The findings of 

the assessment should aid in developing the training plan for these employees in the IT 

applications within the stipulated timeframe. According to Turner (2010), measuring and 

tracking of computer literacy can lead to the development of well-designed and 

appropriate training programs to fit the specific literacy levels of the users. 

Rationale 

Evidence of the Problem at the Local Level  

The 360-bed hospital in UAE, which at the time of the study was in a project 

phase or preoperational stage, had 800 employees. Once fully operational, the hospital 

would have 3,500 employees by end 2015. The current plan was to have the majority of 

the hospital employees onboard by the first and second quarter of 2015. These employees 

would then undergo hospital orientation and various training to prepare them for a mock 

hospital operation. The mock operations would help check functioning of all hospital 

systems and processes and aid in identifying gaps that could then be rectified before the 

final opening of the hospital to patients and community in the second quarter of 2015. 
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One of the major concerns was the ability of the new employees to adequately use 

computers and IT applications, because the hospital would be fully IT integrated with 

more than 72 IT applications that include both clinical and nonclinical applications.  

The clinical and nonclinical staff in the hospital are hired from across the world, 

and it is assumed that some of them may have experience in using computers, electronic 

HIS, or other hospital IT applications, and some may not. Therefore, it is necessary to 

conduct an initial assessment of computer literacy among the hospital employees. An 

accurate assessment will help formulate a customized training plan. The first question to 

answer concerned which was a better method of assessing computer literacy, self-

assessment or an actual skill test. The purpose of this study was to compare the results of 

a self-assessment test and actual skills test administered to assess the computer literacy 

among hospital employees to determine the most effective method of assessing new 

employees’ computer literacy. The most effective method would then be used to assess 

the basic computer literacy of employees and the results utilized for development of an 

effective training program. 

Evidence of the Problem from the Professional Literature 

A review of professional literature revealed the need for proper assessment of 

computer skills among health professionals, especially in health care organizations that 

are in the process of adopting HIS. In a qualitative study conducted by Szydlowski and 

Smith (2009), employees were interviewed from different levels of a health care 

organization to gain a perspective on implementation of health information technology 

(HIT). One of the barriers identified in successful HIT integration was the inability to 
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assess basic computer and software skills necessary for the HIT users and in providing 

appropriate training. In another study, the Agency for Healthcare Research and Quality 

(AHRQ, 2009) reported that one significant barrier in successful implementation of HIT 

in long-term facilities was the lack of computer skills among the staff. Yet another study 

conducted among health care staff in Finland examined the impact of individual factors 

on staffs’ computer use and the factors that inhibit optimal use of computers (Koivunen, 

Välimäki, Koskinen, Staggers, & Katajisto, 2008). Those authors suggested that a 

detailed and systematic IT capacity evaluation of health care staff is necessary to design a 

tailored IT education program and support (Koivunen, Välimäki, Koskinen, Staggers, & 

Katajisto, 2008). A systematic IT capacity evaluation would involve assessment of basic 

computer literacy skills of health care staff.  

Lack of computer skills has also been seen to affect implementation of 

computerized systems in medical practices and in pharmacies. Meinert and Peterson 

(2009), in their study of 358 physicians in a large multispecialty clinic in the Midwest 

region of the United States, discovered that lack of computer skills accounted for much of 

the resistance encountered in adopting EMR technology. Likewise, in a study conducted 

with pharmacists to examine their perceptions of potential barriers to computerization of 

hospital pharmacy systems, pharmacists with a low level of computer literacy rated 

themselves higher on the perception of potential barriers with pharmacy automation 

(Afolabi & Oyebisi, 2007).  

Lack of basic computer skills in health care professionals has been identified as 

one of the barriers in successful implementation and adoption of HIS (Ludwick & 
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Doucette, 2009; Terry, Brown, Denomme, Thind, & Stewart, 2012). There is a definite 

need to assess health care professionals’ basic computer skills prior to the implementation 

of HIS in an organization. A review of literature revealed that self-assessments rather 

than objective skills tests have been increasingly used as a means to assess computer 

literacy among health care professionals (Qiu, Yu, & Hyland, 2007). Self-assessments are 

more commonly used because they are easy to administer and less time consuming. There 

have been almost no studies that tested the actual computer skills of the health 

professionals. 

Self-assessment is an estimate of an individual’s personal ability. In a study 

conducted with first-year business students to evaluate the reliability of self-assessed 

computer competence, the scores obtained by the students were compared to objective 

tests and revealed that students overestimated their computer competence (Ballantine, 

Larres, & Oyelere, 2007). Most studies have reported a moderate relationship between 

estimates of ability and the actual ability (Ng & Earl, 2008). Still, self-assessments 

continue to be used extensively as a tool to assess computer literacy among health 

professionals. This leads to the question, which is a better method of assessment to 

optimize training of IT applications? This study investigated this question and compared 

hospital employees’ scores on a self-assessment and on an actual computer skills test in 

order to determine the most effective method to measure the computer skills of new 

employees of the UAE hospital and offer training according to their levels of literacy. 

Definitions 

The key terms related to this study are defined as follows: 
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Blended learning: According to Horn and Staker (as cited in International 

Association for K-12 Online Learning, 2011), 

Blended learning is any time a student learns at least in part at a supervised brick-

and-mortar location away from home and at least in part through online delivery 

with some element of student control over time, place, path, and/or pace; often 

used synonymously with hybrid learning (p. 3). 

Clinical staff: The term clinical has to do with when one treats patients or 

provides direct patient care of any type. Examples of clinical roles are physician, nurse, 

and allied health professionals such as medical assistants, techs, and therapist (Santiago, 

2015). 

Computer literacy: “Computer literacy content focuses on computer basics and 

the use of generic software applications such as word processing, databases, presentation 

software, and the use of electronic communication such as e-mail” (National League of 

Nursing, 2011, para. 1). 

E-learning: “Education in which instruction and content are delivered primarily 

over the Internet” (Watson & Kalmon, as cited in International Association for K-12 

Online Learning, 2011, p. 7). 

Health information technology (HIT): “HIT consists of an enormously diverse set 

of technologies for transmitting and managing health information for use by consumers, 

providers, payers, insurers, and all the other groups with an interest in health and health 

care” (Blumenthal & Glaser, 2007, p. 2527). 



7 

 

Instructional designer: “Someone who uses the principles of learning, pedagogy, 

and content frameworks to create teaching materials and experiences for online courses” 

(International Association for K-12 Online Learning, 2011, p. 6). 

Instructor-led training (ILT): Involves training that occurs in a classroom setting. 

“This form of training can have one or more instructors; and they teach skills or material 

to another person or group through lectures, presentations, demonstrations, and 

discussions” (Mindtools, 2015, para. 3).  

Learning management system (LMS): “The technology platform through which 

students’ access online courses. A LMS generally includes software for creating and 

editing course content, communication tools, assessment tools, and other features for 

managing the course” (International Association for K-12 Online Learning, 2011, p. 7). 

Nonclinical staff: Nonclinical staffs are that staffs who do not provide any type of 

medical treatment or testing. Nonclinical staff includes medical billers, coders, 

transcriptionists, hospital executives, receptionists, and anyone who works behind the 

scenes such as human resource, IT, and administrative assistants (Santiago, 2015). 

Onboarding: Onboarding is the process of bringing new employees into an 

organization (Harmon, 2013). Onboarding is also “known as organizational socialization, 

onboarding refers to the process by which new employees are made to feel welcome, 

valued, and prepared for a new role that lies ahead of them” (Director, 2011, p.12) 

Significance 

HIT plays a very important role in health care today; it helps in delivery of safe 

and efficient health care. Health care organizations planning to adopt HIT in UAE need 



8 

 

to take into account the basic computer literacy levels of their employees prior to any 

implementation. The success of an HIT implementation would depend on the training 

provided to the employees for the various IT applications. As is the case with any 

training, it is necessary to gauge the existing knowledge and skills prior to the training to 

ensure that the training provided is useful. At the local level, assessing the basic computer 

skills of the hospital employees is a very important factor in the successful 

implementation and acceptance of HIT among the end users. Identifying an accurate tool 

to assess computer literacy will address the training needs of the end users and will 

contribute to tailoring a training program as per individuals learning need and at the same 

time ensure effective utilization of resources required for training. From a social change 

perspective, the results of this study project will guide other hospitals in the region who 

are in the process of adopting and implementing HIT. 

Research Question 

The primary purpose of this study was to identify an appropriate tool to assess 

computer literacy.  

In an organization that is planning to be fully computerized for clinical and 

nonclinical functions, it is important that employees from all job functions and 

departments be assessed for basic computer literacy. This study helped determine the best 

tool for assessing computer literacy that will give a true measure of computer skills. This 

in turn will provide valuable information on the training needs of prospective employees 

allowing departments to develop effective training programs. 

The research questions were as follows: 
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1. What is the best tool to assess computer literacy among hospital employees 

while comparing self-assessment tool and actual skills test?  

2. Does a relationship exist between the self- assessment scores and the actual 

skills tests scores for basic computer literacy among hospital employees?  

Research Hypothesis: The self-assessed scores of computer literacy will be 

significantly higher to that of the scores on the actual skills test in hospital employees.  

Null Hypothesis: There is no significant difference in the computer literacy scores 

obtained in self-assessment and actual skill test in hospital employees. 

Review of the Literature 

My aim in conducting the literature review was to identify tools currently used in 

assessing computer literacy in hospital employees and how does computer literacy relate 

to adoption of HIT or EMR. I also reviewed the literature for HIT and EMR adoption in 

UAE. I used terms such as basic computer skills, computer skills assessment, computers 

in health care, HIT, EMR, barriers in adoption of HIT, barrier is adoption of EMR, 

computer literacy, computer literacy in health care, factors affecting computer literacy, 

assessing computer literacy, self-efficacy, self-assessment of computer literacy, 

constructivism, constructivist learning theory, and self-efficacy theory with the help of 

basic Boolean search operators of and, or, and not. I used the Walden Library’s Thoreau 

Multiple Database Search, Ed/IT Lib Digital Library, Computers and Applied Sciences 

Complete, CINAHL Plus with Fill Text, EBSCO, ERIC, and MEDLINE with Full Text, 

ProQuest, and SAGE Premier. I also used Google Scholar, local UAE newspapers, and 

health authorities’ websites in UAE. 
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Theoretical Foundation 

The theoretical framework for this study was based on constructivist learning 

theory (Yilmaz, 2008) and self-efficacy theory (Bandura, 2006). 

 Constructivist learning theory. Constructivist learning theory is defined as 

“active construction of new knowledge based on a learner’s prior experience” (Koohang, 

Riley, Smith, & Schreurs, 2009, p. 92). The constructivist learning theory forms a basis 

for explaining computer literacy in this study. Constructivism assumes that individuals 

use their prior knowledge, skills, and understanding to create new knowledge or skills 

(Koohang et al., 2009; Richardson & Schunk, as cited in Yilmaz, 2008). Knowledge is 

constructed through reflection and abstraction as an individual adapts to his or her 

environment. Individuals bring their past experiences, beliefs, world views, and cultural 

histories into the process of learning as they construct knowledge internally by interacting 

with the environment (Von Glasersfeld, Kamii, Manning, & Manning, as cited in Yilmaz, 

2008).  

When faced with a new situation or learning environment, an individual can 

experience a state of disequilibrium in his or her mental schemata as one’s previous 

experiences and understanding are contradictory to the new situation (Yilmaz, 2008). To 

reach a state of equilibrium, the individual needs to reorganize or modify his or her 

mental schemata by a process of adaptation, which is accomplished through assimilation 

and accommodation (Gillian, as cited in Yilmaz, 2008). Assimilation is integration of 

new knowledge with prior knowledge, and accommodation involves transformation of 

existing cognitive structures in response to new situation.  
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When individuals are faced with a new learning situation, they draw on their prior 

experiences to understand the new experience. Therefore, acknowledging and assessing 

an individual’s prior knowledge or skills before teaching them new concepts or skills is 

important. This study assessed the basic computer literacy skills of hospital employees 

prior to them receiving instruction and training on use of various HIT applications.  

 Self-efficacy theory. According to the social cognitive theory proposed by 

Bandura (2006), self-efficacy is the belief about the perceived capability to do things. In 

this study, self-efficacy was the belief of hospital employees of their capabilities to 

perform basic computer functions such as printing, saving documents and so forth, and 

using computer applications such as word processing, spreadsheets, e-mail, and searching 

the Internet for information. Bandura asserted that self-efficacy is gained by an individual 

through mastery of experience. According to Bandura (as cited in Mahon, Nickitas, & 

Nokes, 2010), “self-efficacy explains a situation specific confidence that indicates the 

level at which one believes one can successfully perform a task” (p. 616). In this study, 

mastery of experience was related to the way the hospital employees indicated whether 

they can successfully perform basic tasks on a computer. In this study, self- assessment 

was used as a tool to assess the health care employee’s perceived ability (self-efficacy) in 

performing basic computer skills. 

Review of the Broader Problem 

While reviewing the broader problem, I started with the role of computers in 

health care, especially HIT, and what have been the common barriers in adoption of HIT 

in health care. A common barrier and a concern expressed by health care employees was 
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the lack of computer literacy. I then focused on computer literacy and how it is measured 

and what are the tools currently used to measure computer literacy. 

 Computers in health care. Hospitals use a variety of HIT applications for 

clinical and nonclinical functions, and it is necessary that these IT systems are well 

integrated to provide safe and coordinated patient care. Hospitals rely heavily on HIS to 

provide quality patient care and patient safety, and quality care is dependent on 

integration of computerized HIS in the clinical environment (Blaya, Fraser, & Holt, 2010; 

Wallis, 2011; Wilbright et al., 2006). Computers are increasingly used for sorting patient 

information, for documenting patient care, and for accessing health care literature among 

many other health care related functions. There has been growing evidence that by 

adopting HIT, health care organizations can improve efficiency, be cost effective, and 

deliver safe and quality health care by providing clinicians immediate access to best 

practice guidelines and evidence-based databases and by making computerized patient 

records available throughout the health care network (AHRQ, 2006; Simon et al., 2008).  

 Barriers in HIT adoption. In the United States, 8% to 10% of hospitals and 

about 17% of physicians use EMR at the basic level (Herrick, Gorman, & Goodman, 

2010). Even though experts have suggested the perceived benefits of HIT 

implementation, lack of strong evidence of successful HIT implementation has deterred 

many from adopting it. There is lack of substantial evidence or studies to demonstrate the 

effectiveness or success of HIT implementation (AHRQ, 2006; Bates, 2010; Encinosa & 

Bae, 2011; Herrick et al., 2010).  



13 

 

Although IT has permeated into the core functions of health care, the health care 

industry has been slow to embrace computerization (Blumenthal et al., 2007; Pelletier, as 

cited in Booysen, 2009). The slow pace of diffusion of computer technology in health 

care has been mainly due to the huge capital investment required for such initiatives 

along with the uncertainty over return of investment (ROI) for those who pay and those 

who benefit (AHRQ, 2006; Boonstra & Broekhuis, 2010; Hersh, 2010). In addition to the 

monetary or financial investment required to install the IT systems, there are other factors 

that have slowed down the process of computerization in health care, such as complexity 

of IT systems, changing work processes and cultures, and ensuring that hospital 

employees use it efficiently (Blumenthal et al., 2007; McAlearney, Robbins, Kowalczyk, 

Chisolm, & Song, 2012).  

Another reason why some hospitals or physicians have not adopted EMR is due to 

the concerns about data security, privacy, and confidentiality of patients’ health 

information. Acceptance of EMR systems will depend on the confidentiality offered by 

the system (Rynning, 2007). Lack of interoperability or interconnectivity between various 

HIT applications was also cited as a major barrier in adoption of HIT in health care 

(Balas & Sanousi, 2009; Blumenthal et al., 2007). Interoperability is the ability of the 

various HIT applications to talk to each other. Lack of consistent data standards makes 

exchange of data between different systems difficult (Boonstra & Broekhuis, 2010). 

 User acceptance is a major factor in successful adoption of computers in health 

care. Users have identified the log on and log off process as a major barrier to electronic 

health record (EHR) acceptance along with other computer characteristics such as 
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missing cords, misplaced laptops, and dead batteries (Whittaker, Aufdenkamp, & Tinley, 

2009). One other reason for reluctance to use computers in health care by clinicians is 

that they feel it affects their communication and interaction with patients. Nurses have 

described electronic documentation as time consuming, which leaves them with very 

little time for direct patient care (Bride, Delaney, Tietze, 2012; Huryk, 2010; Kunz, 

2010).  

Lack of adequate technical training and support for HIT systems from vendors 

was a significant barrier for HIT adoption (Boonstra & Broekhuis, 2010). The timing of 

the training provided for the HIT also contributed towards the successful implementation 

of HIT. A study conducted in a rural hospital reported that any delay between the initial 

training and the actual implementation can be a significant barrier in EHR adoption 

(Whittaker et al, 2009).  

UAE has only adopted HIT recently. In 2010 the Emirate of Dubai launched 

EMRs, which went live by the year 2012 (Khalaf, 2010; Zain, 2010). SEHA, the Abu 

Dhabi Health Services Company, implemented EMR in its hospitals in 2008 (Manibo, 

2008). The UAE Ministry of Health (MoH) launched the electronic HIS named Wareed 

in 2008, to be implemented in two phases over a period of three years covering 14 MoH 

hospitals and 76 primary health care facilities across Dubai and the Northern Emirates 

(Olarte, 2010). 

Need for computer literacy. A tool is only good if it is used appropriately. 

Similarly, introducing HIT applications in hospitals would serve its purpose only if the 

end users are able to use it appropriately. Hospital employees need to be computer literate 
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to be able to use the HIT applications to provide safe and quality patient care. One of the 

barriers identified in the successful implementation and adoption of EMR was lack of 

computer literacy among the users (Huryk, 2010; Terry, Giles, Brown, Thind & Stewart, 

2009). According to Bryson, to be computer literate, health professionals must have basic 

knowledge of computers, be able to use computer assisted instruction program, and be 

able to use computers as a tool to deliver patient care (as cited in Hsu, Hou, Chang, & 

Yen, 2009).  

Nurses comprise the single largest discipline in the health care workforce. The 

American Nursing Association stipulates that experienced nurses are expected to 

demonstrate basic computer software skills along with other skills like administration, 

data access, monitoring, and research in their practice (Fetter, 2009). Often, however, 

nurses lack the basic computer skills to use the HIT applications, which can be a deterrent 

in successful implementation of HIT in hospitals. In a survey conducted on 454 nurses 

from various categories such as advanced practical nurse, registered nurses, licensed 

practical nurses, nursing assistants and nursing unit clerks, it was reported that the 

majority of the nursing staff were potentially incapable of effectively using computerized 

HIS related to their work (Wilbright et al, 2006). Similarly, a cross sectional survey 

conducted in two tertiary teaching hospitals in Korea collected information on nurses’ 

informatics competency, basic computer skills, and attitude towards computerization and 

revealed that more than half (58.9%) of the nurses rated their computer skills below 

average (Hwang & Park, 2011). A significant portion of nursing workforce consists of 

nurses who graduated or entered the workforce before the introduction of computers in 
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nursing education or health care and it would be interesting to know the levels of 

computer literacy among these nurses. A study reported that more than 28% of nurses in 

a hospital perceived themselves as having fair or poor proficiency in basic computer 

skills and nurses older than 50 years and those who graduated before 1984 scored lower 

in computer proficiency (Wilbright as cited in Hwang et al., 2011). 

The lack of computer literacy among the health care workforce can be a serious 

problem where computerized HIS is increasingly associated with delivery of safe and 

quality patient care. Empowering nurses to be computer efficient will make health care 

delivery safe, efficient, timely, accessible, and patient centered (Kunz, 2010; Technology 

Informatics Guiding Education Reform Initiative, 2009). A well designed HIS can save 

staff’s time in entering and retrieving patient data if they have the basic computer skills to 

enter the data accurately and completely. A study in the United Kingdom among National 

Health Services (NHS) staff which included 69% support staff, 16% of medical, nursing 

and allied health staff, and 15% of primary care staff that the staff who received training 

on basic computer skills saved an average of 39 minutes every day at work while 

working with IT applications (Stephankova & Engova, 2006). Being computer literate 

can save time for health professionals as they spend less time figuring out how the 

application works. 

Factors influencing computer literacy. There are various factors which can 

influence the level of computer literacy or computer competence of health care 

professionals such as age, gender, level of education, experience of working with 

computers , and any education or training undertaken in the use of computers or that 
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required the use of computers (Hsu et al., 2008; Hwang & Park, 2011; Hsu, Hsiao, 

Huang, & Lin, 2006). Individuals who have used computers for personal use or at work 

would be expected to have developed some basic skills related to computer use. Frequent 

use of computers leads to familiarity in use of computers and increases the ability to use 

them effectively (Loyd & Gessard as cited in Ogunkola, 2008) and actually owning a 

personal computer contributed greatly towards frequent use of computers among science 

teachers (Ogunkola, 2008).  

In addition, studies indicate that individuals who had past experience of using 

computers or had training in the use of computers demonstrated basic skills in computer 

use. In a study conducted using self-assessment to determine the factors that influence 

computer anxiety and computer literacy it was shown that computer experience and 

personal innovativeness in IT contributed towards increased computer competence 

among nurses in Taiwan (Hsu et al., 2006). A similar study conducted with Taiwanese 

and South Korean nurses indicated that nurses who had training in the use of computers, 

or had nursing informatics in their nursing curriculum, had higher computer literacy 

levels (Hsu et al., 2009). 

Perceived self-efficacy of computer literacy. The construct of self-efficacy is 

closely linked in the literature to the construct of self-assessment. Self-assessment is the 

information provided by learner’s themselves about their abilities of what they think they 

can do or cannot do (Blanche & Merino, as cited in Coronado-Aliegro, 2006). Therefore 

self-assessment can be considered as a component of self-efficacy. Self-assessments have 

been commonly used in health care to assess health care professional’s computer literacy 
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levels. A self- assessment survey conducted for assessing computer literacy and skills 

among dentists and dental care professionals within primary care in Scotland revealed 

that 43% of the respondents considered their skills to be moderate with one third 

reporting low computer skills and majority of the respondents had self-acquired computer 

skills (Gibson, Jack, Rennie, 2006). The study also identified areas where respondents 

had little or no skills such as, use of spreadsheets, scanners, e-library, Web search skills, 

and file management skills. In a self-assessment survey of computer literacy skills of 386 

pharmacists across two counties in England revealed that the pharmacists lacked skills in 

use of certain software, use of spreadsheets, presentation packages, and in searching the 

Internet for information (Thomas & Ruttert, 2008). 

Nurses, regardless of whether they were in practice or newly graduated nurses, 

perceived themselves as lacking basic computer skills. A self-assessment survey of 1,313 

nurses, midwives, health care support workers and preregistration students from across 

United Kingdom by the Royal College of Nurses (RCN) in 2011 revealed that nurses 

lacked the basic computer skills and confidence in using health care information and 

communication technology (ICT) and these results were consistent with a self-assessment 

survey conducted in 2007 by the RCN (Wallis, 2012). In another study conducted to 

assess the computer and information literacy needs of nurses through a self-assessment 

survey in a community hospital in the US, it was reported that 47% of the nurses reported 

little or no self-perceived competency and a correlation was found between year of birth 

and computer literacy and between educational level and computer literacy (Campbell & 

McDowell, 2011). The study also identified the areas with the least perceived 
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competency as use of spreadsheet, database application, presentation graphics, statistical 

analysis programs, and bibliographic database searching. Self-assessment of graduate 

nurses of their perceived IT competencies revealed that the majority rated themselves as 

having moderate IT skills (Fetter, 2008).  

Assessment of Computer Literacy. One of the barriers identified in successful 

training and implementation of HIT was lack of a detailed training needs analysis 

amongst hospital employees. A barrier which is highly recognized but not studied or 

quantified in successful implementation of HIT is the lack of characterization of the 

workforce and their training needs (Hersh, 2006, 2010; Perlin & Gelinas, 2008). 

Assessing computer literacy would be the first step in performing a detailed training 

needs analysis. There is a lack of research literature on the best method to measure the 

basic computer skills of hospital employees working in health care organizations. Studies 

conducted with nursing students to compare their self-rated computer skills to their actual 

ability to perform the computer skills suggested that the students rated themselves higher 

than their actual performance of computer skills (Elder & Koehn, 2009; Grant, Malloy, & 

Murphy, 2009). Similarly, in a study conducted on students it was concluded that self-

reporting of computer literacy was not a reliable measure in comparison to actual skills 

test, nevertheless the researchers recommend performing a similar study with larger 

sample size and on employees or job applicants for a more generalized result (Merritt, 

Smith, & Renzo, 2005).  

According to Franks-Meeks (2008), a thorough assessment of computer 

competency prior to implementation of an EMR would allow for better planning and 
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education. An assessment of basic computer skills prior to implementation of EMR can 

be an advantage (Terry et al, 2009). Therefore performing an assessment of the newly 

hired hospital employees before the opening of the hospital will allow for proper training 

and planning for the EMR implementation. 

Implications 

One of the concerns the activation committee of the local hospital which was in 

preoperational phase and planning to be fully digitalized is whether the newly hired and 

future employees will have the basic computer literacy to learn and adapt to the hospitals 

IT systems. It is expected that results of this study will help determine a better method of 

assessing computer literacy among hospital employees. The findings of the study will 

identify the gaps in computer literacy and training needs of the hospital employees. The 

project can address these identified gaps in computer literacy and contribute towards a 

well-planned training plan based on individual needs. Far reaching implication of this 

study project might be guidance for other hospitals in the region which are in project or 

preoperational phase or are in the process of implementing or adopting HIT systems. 

Summary 

HIT is permeating the health care industry at a very fast pace and most of the 

hospitals in the UAE and in the neighboring Gulf States are increasingly adopting HIT 

and going paper light. This means that most of the clinical and nonclinical functions are 

now been computerized. For successful implementation of HIT, the end users who are the 

employees of the health care organization need to be proficient and competent in using 

computers. Various researches have highlighted that health care professionals lack the 



21 

 

basic computer skills necessary to operate the various IT applications. The lack of basic 

computer skills has been identified as one of the barriers in successful implementation of 

HIT. 

When introducing HIT in a health care organization the employees need to be 

trained extensively prior to the go-live to ensure successful implementation. To provide a 

training which is practical and useful to the employees whilst using the resources 

adequately requires assessment of basic computer skills of the employees.  

A review of literature reveals that health care professionals like nurses, dentists, 

pharmacists, and physicians lack the basic computer skills required to operate in a 

computerized health care system. Lack of basic computer skills among these health care 

professionals greatly affects the adoption and implementation of HIS in health care. The 

need to assess the computer literacy of health care professionals prior to introduction of 

HIT is emphasized in the literature. Most often in health care the basic computer skills 

are measured using self-assessment even though studies have proved that self-

assessments are not a true measure of actual skills that an individual possesses.  

Studies conducted among nursing students to compare their self-assessment to 

actual skills revealed that students rated themselves higher on the self-assessment. There 

are no similar studies done on working health care professionals and there is a lack of 

literature on the measure of actual computer skills of health care professionals. The 

present study compared the results of a self-assessment to actual skills test to identify a 

tool for accurately measuring the computer skills of hospital employees, which has 

implications at the local level and for the region and UAE. 
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The next section details the research methodology, instruments, data collection, 

and analysis of data. 
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Section 2: The Methodology 

Introduction 

The focus of this study was to compare hospital employees’ self-assessment of 

basic computer skills with their actual computer skills using a quantitative research 

design. This section presents the research design, setting of the study, population, sample 

and sampling technique, data collection instruments, data collection methods, and data 

analysis. 

Quantitative Research Design and Approach 

An explanatory correlational research design was considered appropriate for this 

study as correlational designs allow prediction of scores and explain relationships among 

the variables (Creswell, 2012). The two variables being studied were the scores from the 

self-assessment test and scores from the actual skills test. Correlational research design 

uses the correlation statistical test to measure the degree of association or relationship 

between sets of scores (Creswell, 2012). In this study, the correlational design related the 

scores from the self-assessment of computer literacy and scores from actual skills test of 

computer literacy for each tested hospital employee. 

According to Creswell (2012), in correlational research, data are collected at one 

point in a time and the researcher obtains at least two scores for each individual in the 

study. In this study, I collected the data at one time and collected two set of scores for 

each hospital employee, the first set of scores from the self-assessment and the second set 

of scores from the actual skills test. 
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Setting and Sample 

Setting 

The setting for this study was a new quaternary care hospital that was in a project 

phase or preoperational phase in the UAE. The hospital has a 360-bed capacity. As the 

hospital was not yet operational, the employees were working from an office building 

that was very close to the hospital.  

Population 

During this preparation phase, the hospital had employees, both clinical and 

nonclinical. The population for the study included the clinical staff and nonclinical staff 

of the hospital in Abu Dhabi. The clinical staff, who at that time were not practicing and 

were in the preparation phase, were comprised of employees who would be directly 

involved in patient care such as nurses, physicians, respiratory therapist, physiotherapists, 

phlebotomists, x-ray technicians, pharmacists, and so forth. The nonclinical staff 

involved employees who would not be directly involved in patient care such as 

housekeeping staff, catering staff, receptionists, parking personnel, security personnel, 

patient navigators, social workers, and so forth. The workforce was international and 

diverse with employees representing 53 countries or nationalities. They included 58% 

female employees and 42% male employees. When considering the educational 

background, 71% had a bachelor’s or associate’s degree, 21% had a master’s degree, 

2.5% had a doctoral degree, and 5.5% had a high school diploma. All the employees had 

basic English language skills as the organizations official language is English. 
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Sample Size 

One way to determine the sample size is by selecting a sufficient number of 

participants based on the statistical procedures one plans to use. For applying 

correlational statistics a sample size of minimum 30 participants is needed (Creswell, 

2012). In addition to that, when the intent of the correlational study is to generalize from 

a sample to a population, a sampling error formula should be utilized to determine the 

sample size (Creswell, 2012). A sampling error formula is based on the chance that the 

sample will be evenly divided on a question, amount of sampling error, and a confidence 

interval (Creswell, 2012). For this study, I chose the possibility that there was a 50/50 

chance that an individual might get a question right or wrong. A sampling error of 4% to 

6% is considered appropriate, so I decided to set the sampling error at 6% with a 

confidence interval of 95%. I used the Fowler’s sample size table to estimate the sample 

size based on chance, sampling error, and confidence interval. According to Fowler’s 

sample size table, the estimated sample size for this study would be 300 participants 

(Creswell, 2012). I decided to have a sample size of 500 to account for any missing data 

or incomplete data that may necessitate dropping a participant or more.  

Sampling Method 

A stratified sampling technique was used to select the participants. A stratified 

sampling helps the researcher to stratify the population based on some characteristics and 

then use simple random sampling on each subgroup, which ensures that the sample 

includes the characteristics that the researcher wants to include in the study (Creswell, 

2012). In this study, the two main subgroups were the clinical staff and the nonclinical 
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staff, as I wanted an equal representation from these two subgroups. Another reason for 

choosing a stratified sampling technique is that while using Fowler’s sample size table it 

is recommended to use stratified sampling to reduce the percentage of sampling error 

(Fowler, as cited in Creswell, 2012). Therefore, using a stratified sampling technique 

helped me to reduce the sampling error to less than 6%. 

The hospital employees, which constituted a total population of 800, were divided 

into two subgroups of clinical and nonclinical staff. Staffs in each subgroup were 

numbered from 1 to 400. A randomizer was used to pick 10 numbers at a time from each 

group. The selected numbers were then deleted from the pool of numbers and run through 

the randomizer again to get another 10. This process was continued until the required 

sample size of 500 participants was obtained.  

Eligibility Criteria for Study Participants  

The eligibility criteria for the study were that participants should be able to read 

and communicate in English and be willing to take the actual skills test on the computer.  

Instrumentation and Materials 

A self-assessment survey questionnaire was used to assess the computer literacy 

of the hospital employees, following which, the employees were administered a 

simulated actual basic computer skills test. Each participant was provided with a 

personalized report on request, so that he or she could seek additional training for the 

areas where skills were less than adequate. 

Both the instruments were composed in English as employees in the hospital are 

required to be proficient in English as part of the recruitment selection process. A new 
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instrument for self-assessment and actual computer skills test was created instead of 

using a preestablished measure so that items in both the tests matched one another. 

Creating a new instrument allowed for including items that are considered important 

computer skills for health care employees to operate the different HIT applications within 

the hospital. 

Prior to construction of the instruments for data gathering, an informal interview 

was completed with managers and heads of the various departments to identify the basic 

computer skills they felt were necessary for the employees to use the various HIT 

applications. The research instruments where then constructed to reflect these basic 

computer skills. Components such as multimedia presentation and troubleshooting 

common technology problems were left out as these skills were not considered to be 

basic or essential for the hospital employees to have in order to use the hospital IT 

applications.  

Self-Assessment Survey Questionnaire 

The self-assessment questionnaire (Appendix E) was segregated into modules that 

corresponded to the components of computer literacy such as word processing, 

spreadsheet, e-mail, Internet, and general PC skills. Each module had items that tested the 

perceived ability to perform particular computer applications tasks. A Likert scale with 

responses of always, sometimes, and not at all was used. The survey questionnaire was 

reviewed by IT specialists to ascertain content validity and wording of the questions. The 

survey questionnaire was piloted on 50 hospital employees from various departments. 
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 Computer Skills Test 

The computer skills test (Appendix F) was administered using a computer 

simulation test created using Adobe® Captivate. Creating a simulation test provided me 

with the flexibility to choose questions that matched the items on the self-assessment 

questionnaire. The simulated computer skill assessment instrument was pilot tested to 

establish validity and reliability. The pilot test was conducted with 50 participants. The 

pilot test participants included both clinical and nonclinical hospital employees who 

represented the research participants and were excluded from the final research sample to 

avoid any bias or contamination of sample. The items on the skills test corresponded to 

the items on the self-assessment test. The computer simulated test measured whether the 

employee could actually perform the task on a computer.  

Reliability of Instrument 

The reliability of the self-assessment instrument was ascertained by test-retest 

wherein the retest was administered four weeks after the initial test. The Pearson product 

moment correlation was used and value of r was calculated to be 0.90, which is 

considered a positive correlation. A measure of 0.80 or higher indicates high degree of 

consistency or reliability (Lodico, Spaulding, & Voegtle, 2010, p.87) 

The actual skills test was tested for internal consistency using split half reliability 

after administering the initial test. Split half reliability was carried out to rule out any bias 

that may occur with test-retest. The test was split into odd and even numbered questions. 

The value of Cronbach’s alpha () and Kuder Richardson Formula 20 (KR 20) was 0.70 

and a Spearman Brown Prophecy Formula had a value of 0.80. A Cronbach’s alpha of 
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value 0.70 to 0.90 is considered acceptable measure of reliability (Tavakol & Dennick, 

2011, p.54) 

A reliability of actual skills test was also completed using test-retest method and 

the Pearson product moment correlation r was 0.80, which is an acceptable measure of 

reliability. The self-assessment test and actual skills test was proved to be a reliable tool 

to measure basic computer literacy. 

Validity of Instrument 

Content validity was accomplished for both self-assessment and actual skills test. 

A panel of ten experts from the IT department who work with the different IT 

applications within the hospital were provided the tools to provide feedback on the 

wording of the questions, ease of understanding the instructions, difficulty in 

comprehending the questions, and whether the questions measured the basic skills related 

to the skills set such as general windows, Internet, e-mail, Word, and Excel. The 

feedback was positive with no recommended changes.  

Data Collection and Analysis 

A pilot test was done to test the reliability and validity of the tool. I administered 

the tests through the hospital learning management system (LMS). The data was 

collected by administering the participants’ with a self-assessment survey followed by an 

actual simulated skills test on basic computer literacy. The participants’ logged into the 

LMS with their username and password to take the self-assessment survey and the actual 

simulated skill test. The scores from the self-assessment and actual skills test were 

exported from the LMS into an Excel file.  
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Ethical Treatment of Human Participants 

Measures were taken to protect participants’ rights. For this study, after I obtained 

permission from the hospital and the institutional review board (IRB) approval from 

Walden University (Appendix C), an application was submitted to the chief of human 

resource (HR) and chief executive officer (CEO) for their final approval. On obtaining 

the final approval (Appendix D) data collection process was started. It was 

communicated to the hospital employees’ that participation in the study is voluntary and 

they could withdraw anytime. The participants were explained the purpose of the study 

and a written informed consent (Appendix B) was obtained from each participant. The 

participants’ were administered the self-assessment survey and skills test online using the 

LMS. The participants’ were required to login into the LMS with their unique username 

and password. The results were kept confidential because as a training administrator on 

LMS, I could create an audience and get reports on the LMS without anyone else having 

access to the information.  

The participants’ were provided with a personalized and fully confidential report 

of their computer literacy at the end of the data collection on their request. This 

personalized report would help them to plan their professional development in areas they 

need to develop. The hospital management will be provided with a compiled report of the 

findings of the test results while maintaining the confidentiality of the participants’. The 

management can then make provisions to provide basic computer literacy sessions for 

their staff prior to implementation of HIS.  
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Pilot Test 

Both the measurement instruments self-assessment survey for computer literacy 

and actual skills test for computer literacy were piloted using a test- retest. The pilot was 

conducted on 50 participants’ from various departments. The retest was administered four 

weeks after the initial test. Permission to conduct the pilot was obtained from the CEO 

and the chief of HR. The chief of HR sent out an internal communication to all the 

departments about the pilot. The participation for this pilot was on a voluntary basis. I 

met with the participants’ of the pilot after it was completed to obtain feedback on the 

tool.  

Data Analysis  

The tests were administered to a sample size of 500 hospital employees’ of which 

200 employees’ actually completed both tests. Some of the data had to be discarded as it 

was incomplete and, in certain cases, the employees’ had taken only one of the two tests. 

After sorting through the data collected and discarding unusable data the total number 

came down to 182 (N=182). Each module or skill set in the self-assessment questionnaire 

and computerized skills test was scored based on the number of tasks or items within the 

module or skill set that the participant was able to accomplish. The range of scores for 

each skill set or module and the overall test were set from 0%-100%. For each item on 

the self-assessment test participants’ had to choose the appropriate response on the Likert 

scale of always, sometimes, and not at all. For analysing the data, a score of one was 

assigned if the response was not at all, a score of two for sometimes, and a score of three 

for the response always. In case of the actual skill test, if the participant performed the 
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right skill they received a score of one and if they did not perform the skill they got a 

score of zero. For each module the scores were totalled and a percentage was calculated 

for both self-assessment and actual skills test. The data from the instruments were entered 

into a computer file and then data was analyzed using SPSS software. The percentage 

scores for each skills set or module and overall scores was calculated for both self-

assessment and actual skills tests and compared for each participant, keeping a margin of 

 10. If the scores for both the tests matched, then it was classified as accurate 

assessment. If the scores from self-assessments were greater than the actual skills test 

scores then they were classified as over assessment of skills. If the actual skills test scores 

was greater than the self-assessed scores, then it was considered as under assessment of 

skills (Table.1). An accuracy range of -10 and + 10 was considered.  

Table 1 

 

Classification of Scores 

Comparison of Scores Classification 

Self-assessment scores =  Actual skills score with 

accuracy range of  10 

Accurate 

Self-assessment scores ˃ Actual skills score with 

accuracy range of  10 

Over assessment 

Self-assessment scores ˂ Actual skills score with 

accuracy range of  10 

Under assessment 
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Study Assumptions, Limitations, Scope and Delimitations 

Study Assumption 

My assumptions were that the employees may overrate themselves and that their 

scores on self-assessment might be higher than their actual skills test. 

Study Limitations 

This study had some limitations; one of them was the sample size of 182. I had 

difficulty in getting the selected sample to participate in the study as the hospital was 

moving from a project phase to the preoperational phase and employees’ were busy 

meeting all the health care regulation requirement for inspection and licensing. I had 

expected a sample size of 500 so that the results could be generalized to a larger 

population. The sample size of 182 limits the generalizability of the results. Another 

limitation is that I did not explore the effect of culture on participants’ response to self-

assessment test. This could have a considerable effect on the findings of the study. 

Scope and Delimitations 

The scope of the study was to find an appropriate instrument to measure computer 

literacy in hospital employees’ prior to providing IT training on different applications. 

The delimitations identified in this study were:  

 The participants’ were limited to one hospital, as I failed to get permission 

from other hospitals that were in similar preoperational phase. Including 

participants’ from other hospitals would have made the results more 

generalizable. 
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  Only full time employees were included in the study, there are contracted 

employees working on the project that are usually contracted for short period 

of 3 months, 6 months or a year. These contracted employees are mainly 

consultants working on the project and would not have been a true 

representation of the population. The other set of contracted employees are 

operational support staff like gardeners, drivers, window facade cleaners, and 

valet parking that would not be using IT applications for their day to day 

work. 

 All participants could read and understand English. 

Protection of Participants’ Rights 

Measures were taken for protecting participants’ rights including maintaining 

confidentiality, obtaining informed consent, and protection from any harm. I obtained 

permission from Walden University’s IRB and from the local organization where the 

study was conducted. The organization does not have an IRB as it is still in a 

preoperational phase. I presented my research proposal to the CEO and chief human 

resource officer (CHRO) of the organization and was granted permission to do the study. 

The research participants’ were asked for an informed consent prior to their 

participation in the research. The informed consent explained participants’ their rights, 

voluntary nature of participation, right to ask for information and clarification, and also 

the right to withdraw from the study anytime they wanted to. 

I assured the participants’ and the CHRO that all information will be kept 

confidential. I created a separate testing account on the LMS so that only I had access to 
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the information and results of the tests. No personal or demographic information was 

gathered from the participants’. All the reports generated from the LMS in an Excel 

format were saved on my computer that is password protected. 

Data Analysis Results 

The first step was to analyze the results to find whether the data supported the 

research hypotheses or not.  

Research Hypotheses: The self-assessed scores of computer literacy will be 

significantly higher to that of the scores on the actual skills test in hospital employees. 

Null Hypothesis: There is no significant difference in the computer literacy scores 

obtained in self-assessment and actual skill test in hospital employees. 

As per the research hypotheses it was thought that the hospital employees might 

over assess themselves based on the literature review. An analysis of the overall scores 

from the self-assessment test and the actual skills test was conducted and results 

categorized as accurate, over assessment, or under assessment. Next, a mean frequency 

and percentage was calculated using SPSS which is displayed in Table 2, where n=182 

and majority of the participants (70 %) accurately assessed their computer skills. 

Table 2 

 

Frequency Distribution of Overall Basic Computer Skills 

Score Category Frequency Percentage 

Accurate 128 70.3 

Over Assessment 45 24.7 

Under Assessment 9 4.9 
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To check whether this was significant a paired t- test was done. The results 

indicated that the mean for self-assessment scores (M= 97.80, SD = 5.13) was 

significantly greater than the mean for actual test score (M= 87.87, SD = 9.29), t (181) = 

13.53, p ˂ 0.01. The 95% confidence interval for the mean difference between the two 

scores was 8.48 to 11.37. On basis of this the null hypotheses was rejected as p value was 

significant at 0.01. Therefore, it can be concluded that hospital employees score higher on 

self-assessment than on actual skills test.  

 The next step was to find an answer to the research question. 

Research question: Does a relationship exist between the self- assessment scores 

and the actual skills tests scores for basic computer literacy among hospital employees?  

A scatterplot was used for the graphical display of data between the overall scores 

from the self-assessment and the scores from actual skills test for each individual. A 

scatter plot is very useful in displaying the relationship between two quantitative 

variables which is measured on the same individual (Moore & McCabe, 2006). The 

scatter plot (see Figure 1) was analyzed to search for an overall pattern and for any 

deviations from the pattern. The scatter plot (see Figure 1) showed a roughly linear form, 

a positive direction, and strength of relationship between the two quantitative variables 

was weak. 
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Figure 1. Scatter plot of self-assessment scores and actual skills tests scores of basic 

computer literacy. 

 

As the relationship between the two variables was linear, a correlational statistics 

such as Pearson product moment correlation was applied to measure the strength and 

direction of the relationship between the two variables. A Pearson product moment 

correlation is appropriate as the variables are categorical. There was a weak correlation or 

negligible correlation between self-assessment scores and actual skills scores although 

there was positive linear correlation, r (180) = 0.156, p = 0.035. To measure the strength 

of correlation, I calculated the coefficient of determination, which is obtained by squaring 

the value of r. Here r
2
= 0.024, which means that only two percent of the variability in 

actual skill test scores can be determined or explained by scores of the self-assessment 

test.  
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The next step was to measure the significance of this value, which was t (180) = 

2.119, p˂ 0.05. This means that correlation was significant at 0.05 level and the results 

can be inferred from the sample size to the larger population. 

I compared the performance of computer skills in each module based on the 

categorization of under assessed, accurate and over assessed to identify the areas where 

hospital employees lacked actual skills.  

 

Figure 2. Comparison of computer skills in different modules or areas and overall scores. 

 

According to Figure 2, employees over assessed themselves in performing skills on Word 

and Excel, these were areas where they lacked actual skills 

Conclusion 

The purpose of this research was to find an appropriate tool between a self-

assessment test and an actual skills test, for assessing basic computer literacy in hospital 

employees prior to engaging in training on specific health IT applications. It was 

expected that the results of this study would then inform the development of computer 
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training for basic skills. The paired t- test showed that the mean of the self-assessment 

scores were significantly higher than the mean of the actual test scores and there was a 

weak correlation between the scores on self-assessment and actual skills test, r (180) = 

0.156, p = 0.035. These results show that hospital employees in general tend to score 

higher on self-assessment test compared to the actual skills test. On comparing the scores 

on individual IT modules employees over assessed themselves on skills pertaining to 

Word and Excel applications. Statistically there was no relation or a weak relationship 

between self-assessment scores and scores on the actual skills test, and the correlation 

was significant at value of 0.05. Considering all the above data, a self-assessment test 

cannot be used as a measure to predict the performance of an individual in the actual 

skills test while assessing basic computer literacy among hospital employees. It can also 

be concluded that an actual skill test is a better and reliable tool to measure basic 

computer literacy among hospital employees. 
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Section 3: The Project 

Introduction 

The main purpose of this study was to find an appropriate and reliable tool to 

assess basic computer literacy amongst hospital employees in a hospital, which was in a 

preoperational phase and gearing up to get operational by 2015. The intention was that 

the assessment of basic computer literacy would help in optimizing the available 

resources and provide direction on how to provide effective training on the various IT 

applications required of hospital employees once operational. The explanatory 

correlational research focused on determining an appropriate tool to measure basic 

computer literacy by comparing the scores of self-assessment test and actual skills test. 

 The study results reflected that hospital employees scored higher on self-

assessment test when compared to actual skills test and there was a weak statistical 

correlation between the scores of self-assessment and actual skills tests. Based on the 

findings of the study, an actual skills test is a reliable indicator of their basic computer 

skills. The study also identified skills gap in Word and Excel application. The next step 

was to utilize the findings of the study and develop a project. This section focuses on how 

an actual skills test will be used to categorize hospital employees and how IT training on 

basic computer skills will be provided to prepare them for the hospital wide IT 

applications. 
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Description and Goals 

Description of the Project 

In this project, the actual skills test will be administered to all new hospital 

employees during their onboarding week and the results will be used to identify learning 

gaps and training provided accordingly. This project will focus on developing a training 

plan for the basic computer skills. The training will be delivered using a blended format, 

which is a combination of ILT and e-learning, for which the LMS will be used. A 

blended learning approach was used as the hospital in future would be using e-learning as 

a delivery method for training. 

Rationale for Project Genre 

According to Cortelyou-Ward, Noblin, and Martin (2011), before implementation 

of EMR, the level of computer skills of staff should be evaluated and proper training of 

basic computer skills should be provided before implementation can begin, especially 

when there is strain in resources for providing training. The hospital that was in the 

preoperational phase was slated to be fully digitalized once open to patients in UAE. This 

translates into hospital employees using more than 72 IT applications throughout the 

hospital for various clinical and nonclinical functions. Resources being limited in terms 

of trainers and time; the biggest foreseen challenge was the training of hospital 

employees in all these IT applications. Another perceived challenge was the complexity 

of the composition of employees who constitute more than 52 nationalities and having 

varying levels of computer skills. The study focused on assessing the basic computer 
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literacy levels of the hospital employees using an appropriate tool. The findings of the 

study showed that an actual skills test is a reliable tool to assess basic computer skills.  

In their study, Bredfeldt, Awad, Joseph, and Snyder (2013) found that new users 

of EHR/EMR were overwhelmed with the training and their initial focus was on gaining 

basic proficiency rather than efficiency and mastery. The basic computer skills necessary 

to work effectively with HIT include ability to use office software such as Word and 

Excel spreadsheet, communicating electronically via e-mail, and conduct Internet 

searches (Gripenberg, 2011; Peace, 2011). In the study, I assessed hospital employees’ 

basic computer skills in areas such as general Windows, Word, Excel spreadsheet, use of 

Internet, and e-mail. The project will utilize the findings from the actual skills test to 

provide training in basic computer skills, which will prepare the hospital employees for 

the more advanced or complex IT applications while optimizing the available resources. 

Project Purpose 

The purpose of the project is to address the gaps in basic computer skills 

identified during the assessment of the basic computer literacy through training. 

Project Goals 

The goal of the basic computer skills training program is to integrate the computer 

skills into content areas so that the computer skills are not taught in isolation. The 

expected result is that the hospital employees not just learn to operate computers but are 

able to use the skills as a tool of communication, organization, research, and problem 

solving. The basic computer skills training program acts as a foundation for learning 

other hospital IT applications. 
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Project Learning Outcomes 

The project learning outcome is that the new employees are equipped with the 

basic computer skills so as to enable them to learn more advanced computer skills 

required for the various hospital IT applications. 

Project Target Audience 

The target audiences for the project are the new hospital employees who will be 

joining the organization. 

Addressing the Problem Through the Content of the Project 

The project is to provide training on basic computer skills based on the results of 

the actual skills test. After the new employees do their actual skills test, they will be 

categorized into three groups: beginners, intermediate, and advanced. There are some 

basic skills that every new employee should have to work with the computer systems in 

the hospital. Therefore, I will have a core IT orientation Level 1 program that will be 

mandatory for every employee to attend; this will include orientation to their laptops or 

desktops, use of virtual private network (VPN), use of Microsoft Lync, use of LMS, use 

of hospital intranet, use of Internet Explorer, Microsoft Outlook, and use of secure 

printer. After they have completed the core program, the beginners and intermediate 

group will attend the core IT orientation Level 2 courses on Word and Excel, and then 

proceed into different tracks, Track 1 for beginners and Track 2 for intermediate, while 

the advanced group can go into the hospital IT applications directly. The below (see 

Figure 3) is a framework that will be used for the project. 
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Figure 3. Framework of IT training for basic computer skills. 

 

The aim is to incorporate this training into the present onboarding program and 

departmental orientation period, so that they are equipped with the basic computer skills 

before they go in for their IT applications training. The below (see Figure 4) is the current 

plan in place for onboarding new employees. 
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Figure 4. Current onboarding plan of new employees. 

 

With the project, I propose to equip the new employees with the basic computer 

skills prior to their IT applications training (see Figure 5). 
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Figure 5. IT training project incorporated within the onboarding plan. 

 

Project Outline 

This is an outline of the project. The complete detail along with the PowerPoint 

slides, trainers manual along with tasks and activities are provided in Appendix A. 

Week 1. Assessment of basic computer skills using the actual skills assessment 

tool 

Week 2. Core IT Orientation Level 1 (Duration 2 hour includes 15 min Break) 

This is mandatory for all employees and this is scheduled on week two of the orientation 

program. 

Objective. To orient the new employees to the IT applications needed for day to 

day business functioning. This includes: 

 How to login to the computer using username and password 
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 Using Microsoft Outlook and Microsoft Lync for communication 

 Accessing organization XXX’s intranet and searching for information 

 Accessing the Virtual Private Network (VPN) 

 Print using the follow-me printing using the ID badge 

 Access the Learning Management System (LMS) 

Week 3. IT Orientation Level 2 (3 hrs. including 15 min break) 

This is mandatory for all employees who fall under the beginner and intermediate 

category and this is scheduled on week three of the orientation program. 

Objective. By end of this orientation, participants will be able to: 

 Perform Internet search 

 Perform basic functions of Microsoft Word 

 Perform basic functions of Microsoft Excel 

Week 4 – 6. Completion of Track 1 and Track 2 

Note to trainers. Assign the following courses on LMS as per the participants’ 

level of IT skills. 

Course completion requirements. Participants have to score more than 80% in 

each module to consider it as completed. Participants can attempt the tests multiple times. 

Beginners. Will complete Track 1 in LMS, which includes the following: 

 Beginner Skills in Microsoft Word 

 Beginner Skills in Microsoft Excel 

 Intermediate Skills in Microsoft Word 

 Intermediate Skills in Microsoft Excel 
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Intermediates. Will complete Track 2 in LMS, which includes: 

 Intermediate Skills in Microsoft Word 

 Intermediate Skills in Microsoft Excel 

 Advanced Skills in Microsoft Word 

 Advanced Skills in Microsoft Excel 

Week 6-8. Participants’ will be attending the IT hospital applications training. 

Objective. The employees will get to apply the skills that they learned in week 4-6 

Note for trainers.  

 Assess transfer of learning by observing how the participants perform in the 

IT applications class 

 For interested participants in the beginner level, you can assign advanced 

courses on LMS 

Week 9. Feedback and evaluation. This includes feedback from IT trainers and 

the survey. 

Rationale of How the Problem will be Addressed Through the Project 

The local problem was the concern of whether hospital employees will have the 

necessary basic computer skills to learn and adapt to the various HIT applications across 

the hospital functions. The project will utilize the results from the basic computer literacy 

assessment to identify the gaps in basic computer skills and propose a training curriculum 

to address the gaps. 
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Review of the Literature  

While conducting the literature review I was looking for an effective 

methodology for teaching basic computer skills and used terms such as, basic computer 

skills, computer skills training, IT skills training, IT skills , training, teaching, health 

care, blended learning, explicit instruction, constructivism, Scaffolding, and adult 

learning theory with the help of basic Boolean search operators of and, or, and not. I 

used the Walden Library’s Thoreau Multiple Database Search, Ed/IT Lib Digital Library, 

Computers and Applied Sciences Complete, CINAHL Plus with Fill Text, EBSCO, 

ERIC, and MEDLINE with Full Text, ProQuest, and SAGE Premier and filtered my 

search to include articles from the year 2010 to 2014.  

The blended learning methodology used for providing basic computer skills 

training is based on adult learning theory, constructivism, explicit instruction, and 

scaffolding. 

Adult Learning Theory 

One of the principles of adult learning is that adult learners need to know why 

they need to learn something, and learn better if they perceive it to be relevant to real life 

situations (Class, 2013; Luna & Cullen, 2011; Mirci & Hensley, 2010; Rapchak & 

Behary, 2013; Quinney, Smith, & Galbraith, 2010). For my project, I would be meeting 

with the hospital employees during their first week of onboarding and explain to them the 

reason for administering the actual skills test and how the results will be used to provide 

basic computer skills training, which will prepare them for the more advanced IT 

applications training. The actual skills test will help to demonstrate a gap and develop the 



50 

 

desire to learn basic computer skills. To make the learning more relevant and applicable 

to real life, I would be teaching the skills which they will require at work. 

Integrating e-learning with traditional instructor led training is a catalyst towards 

applying adult learning theory in practice, where teachers or educators are no longer mere 

distributors of content, but are involved as facilitators of learning and assessors of 

competency (Blobel, Engelbrecht, Shifrin, Trukhacheva & Pupyrev, 2012; Goddu, 2012). 

The trainers involved in this project will play the role of a facilitator and support person 

and all learning activities and evaluations are learner centered. 

Another principle of adult learning theory is that individual differences increase 

with age, therefore adult education should be tailored in such a way to cater to differences 

in learning style, time, and pace of learning (Knowles, Holton, & Swanson, as cited in 

Herbold, 2011). The asynchronous format of the project allows learners to absorb the 

learning at their own pace. 

Constructivism 

Constructivism encourages learners to be actively involved in the learning 

process. Constructivists believe that learners achieve deep learning when they are 

actively engaged in learning and process the new information gained and integrate it with 

their prior knowledge (Vogel-Walcutt, Gebrim, Bowers, Carper, & Nicholson, 2011; 

Overbay, Patterson, Vasu, & Grable, 2010). Through this project I would be providing 

the hospital employees with the basic computer skills in a blended format so they are 

actively involved in creating their own personal experience. Constructivist suggest that 

teachers should pay attention to what learners already know prior to them getting 



51 

 

involved in constructing new knowledge or learning new skills (Çalik, Ayas, & Coll, 

2010; Rolloff, 2010; Brandon & All, 2010; Yoder, 2014). I would be assessing the 

hospital employees’ basic computer skills using the actual skills test prior to providing 

training on the computer skills. 

Use of technology for instruction supports the constructivist approach, where 

learners use technology to discover and construct knowledge (Overbay et al, 2010; 

Gracia, Pacheco, & Gracia, 2010; Chitanana, 2012; Al-Huneidi et al, 2012). Furthermore, 

adopting a learner centered constructivist approach to teaching and learning develops 

learners into lifelong learners (Winstone & Millward, 2012). This supports my approach 

of using blended format for delivering training on basic computer skills and in using 

constructivist approach to developing learner centered lesson plans, instructional 

materials, and evaluation. Constructivist approach encourages learners to take ownership 

for their learning (Rolloff, 2010; Chitanana, 2012; Cook, 2014). The blended format of 

learning allows learners to have control and flexibility during the learning process.  

Blended Learning 

A blended learning is a combination of the traditional classroom or face to face 

instruction with web based online approaches, or it could be a combination of 

technologies or a combination of methodologies or pedagogic approaches (Al-Huneidi & 

Schreurs, 2012; Sharma, 2010; Tucker & Jones, 2010). In my project I used a 

combination of classroom teaching and online learning, and a combination of pedagogic 

approaches such as, explicit instruction, constructivism, and adult learning theory. 

According to Carte, Dharmasiri, and Perera (2011), using a blended learning format can 
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serve the purpose of simultaneously delivering content and improve IT skills. Using a 

blended approach in my project will help the employees to improve the skills which they 

learn in class and give them an opportunity to apply those skills on the online learning 

environment. 

Considering the practical nature of the training the biggest challenge was to find a 

methodology which would actively engage the employees and ensure that the skills that 

they learn are transferrable to other areas of their work. According to Tshuma (2012), this 

can be achieved when learning occurs with computers rather than about computers, 

wherein the computer functions as an intellectual partner with the learner to keep them 

engaged and facilitates critical thinking, and encourages deep learning. Integration of 

technology in pedagogy contributed greatly towards acquiring technology literacy 

(Gardner, Emanuels, & Aleksejūnienė, 2011).  

For the project, I used asynchronous format for online learning. Asynchronous 

learning allows great flexibility as it allows students to complete their assignments or 

learning tasks at a time which is convenient for them (Sherrod & Sherrod, 2013). The 

employees will be assigned courses or tasks through LMS to be completed at their own 

convenience. These are courses available as additional resources from Microsoft for use 

by the organization. I used these resources to supplement the classroom instruction which 

I had developed. 

While implementing an EMR/HIS training program for 4000 end users in a 

quaternary hospital in India, the trainers successfully used a blended format for training 

when faced with challenges such as, constraints with duration of training block, lack of 
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training space and equipment, limited number of trainers, and lack of protected time for 

training for end users with their busy hospital work schedule (Kumar, Bhatia, & Chiang, 

2013). Though I am providing training on basic computer skills rather than EMR/ HIS, 

the challenges are similar to a great extent in terms of time available for training, and 

resources in the form of trainers and using a blended format will address these 

challenges. 

Explicit Instruction 

In explicit instruction the students are guided through the learning process by 

providing them with clear purpose and rationale for learning the new skill and includes 

demonstration of skill with opportunity for practice along with feedback till they achieve 

independent mastery of the skill (Archer & Hughes, 2011; Clark, Krischner, & Sweller, 

2012). Explicit instruction is based on the principle that if the learner can understand how 

learning the new concept or skill can be applied to their daily life or work life, they will 

be motivated to learn the new concept or skill (Ashby, Tollefson, Whalen, & Zager, 

2012). For the classroom instruction I used the I-We-You framework which is based on 

explicit instruction, which guides the learner from observation to guided practice to 

individual practice of a skill. For example, the trainer will show a skill of how to print a 

document and the learner will just observe, then in the next step the learner follows step 

by step instruction along with the trainer, lastly the learner will independently perform 

the skill.  
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Scaffolding 

Explicit instruction and constructivism along with the blended approach allows 

for scaffolding , which describes how learning should be supported until novice learners 

are able to master and perform tasks independently (Gripenberg, 2011; Winstone et al, 

2012; Yoder, 2014; Rourke & Coleman, 2010; Melero, Hernandez-Leo, & Blat, 2012; 

Salyers, 2014; Rodrigues & Smith, 2014). The trainers along with the LMS 

administrators and IT helpdesk will be the support system for the learners. Job aids or 

user guides will also be provided as a support.  

There are different types of scaffolding used in ICT education. One of the most 

common ways of classification is based on the granularity of the learning process, which 

is macro scaffolding and micro scaffolding (Melero et al, 2012; Engin, 2014). Macro 

level scaffolding includes the pedagogical approach and instructional strategies used to 

deliver the training (Engin, 2014; Winstone et al, 2012). This project is based on macro 

scaffolding as the instructional design and materials are based on constructivism, explicit 

instruction, and adult learning theory. The micro level scaffolding includes the interaction 

which occurs between the facilitator, or trainer and the learner, which could be in the 

form of cues, questions, elaboration, confirmation, or summarizing (Engin, 2014). The 

project includes classroom face to face interaction with the trainer/facilitator which 

provides the micro scaffolding to the learners. 

One other way of classification is based on the guidance or support provided to 

the learner. This includes social guidance scaffolding and system guidance scaffolding. 

Social guidance scaffolding occurs when more experienced or knowledgeable people 
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guide or assist the learner (Melero et al, 2012; Ozan, 2013). In this project the learners 

have social guidance scaffolding in the form of trainers, IT helpdesk personnel, their 

peers, and other experienced work colleagues. System guidance scaffolding occurs when 

technological approaches or different environmental supports are provided to the learners 

during the process of learning (Melero et al, 2012; Lu & Zhang, 2013; Jančařík, 2013). 

This project provides system guidance scaffolding in the form of LMS and other web 

based resources. 

Project Description 

Project Resources 

The resources required for this project are already available within the 

organization. There is a computer lab set up for hospital IT applications training, which 

can be utilized for the basic computer skills training. There are two labs with each having 

a capacity to accommodate 25 learners. The organization uses a Learning Management 

System (LMS) which can be used to deliver the online learning modules. The Learning 

and Development (L&D) team has instructional designers who can help convert the 

content of training into Shared Content Object Reference Model (SCROM) packages 

which is compliant with the LMS system being used. There are two business applications 

trainers who can deliver the face-to-face training. If additional trainers are required, we 

could do a train the trainer program and empower employees with advanced computer 

skills to provide the training and support required by their fellow employees. 
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Existing Supports 

I have the support of the Senior Director, Learning and Development, the CHRO, 

and CEO of the organization to do what is needed to up skill the new employees to 

facilitate IT training in different applications throughout the hospital. The senior 

leadership is supportive and is aware of my research project and sees it as a value added 

proposition. The hospital IT applications training is outsourced and the project team is 

already on boarded, who are very supportive and keen to offer assistance when needed. I 

plan to get the content and materials reviewed by the members of that team.  

There are desktops or laptops provided to employees and clinical staffs receive 

tablets for use throughout the hospital, department, and unit orientation. For employees 

who do not have individual desktops, laptops, or tablets, there are desktops provided in 

common areas throughout the hospital, offices, and the staff accommodation where they 

can access the LMS. 

Potential Barriers 

The only challenge I perceive is incorporating the basic computer skills training 

during the onboarding and orientation period which is the first two weeks. The 

onboarding program and orientation program is already designed and approved and I will 

have to work around it to include the training. Timing and duration of the classroom 

sessions will have to be carefully managed so that new employees do not find it 

overwhelming. 
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Potential Solution to Barriers 

Potential solution would be to negotiate with stakeholders and propose a two days 

of training dedicated for core IT orientation level one and level two prior to the hospital 

based IT applications training. 

Proposal for Project Implementation and Timetable 

The project implementation will start by presenting the findings of the study and 

the project plan to Committee for Activation and Training (CAT), this committee 

oversees all the training required for activation of the hospital. The next step will be to 

get the curriculum reviewed by experienced IT professionals and submit the curriculum 

to the CAT, along with all training materials, resources, and evaluation plan. Once the 

plan and curriculum is approved, the training for basic computer skills will be initiated by 

Jan 2015. During implementation, there will be overlap of dates as the employees are on 

boarded in small batches every week starting January 2015. 

Week 1: Assessment of computer literacy from Jan 2015- Feb 2015 

Week 2: IT orientation level 1 from Jan 2015 – March 2015 

Week 3: IT orientation level 2 from Jan 2015 – March 2015 

Week 4-6: Track 1 and Track 2 from Jan 2015 – April 2015 

Week 6-8: IT applications training from Feb 2015 – May 2015 

Week 9: Evaluation and survey March 2015 – May 2015 

Roles and Responsibilities of Learners and Others  

Learners. This project uses a blended learning format and learners who are the 

new employees need to understand that major portion of this training is self-directed. 
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Being the project lead it will be my responsibility to make sure the learners learn how to 

use the LMS and they know what is expected of them as learners. This information will 

be imparted to them during the Core IT orientation. The learners need to understand how 

they can use the support available to them in the form of trainers, IT helpdesk, LMS 

administrators, and colleagues. 

Other stakeholders. Prior to implementation, I will have to meet with other 

stakeholders who are vital for the success of the project. These include the IT support or 

helpdesk staff who would be providing assistance with any IT issues, the LMS 

administrators who will be supporting the learners to overcome technology issues with 

the LMS, onboarding team as I will providing the actual skills test during the onboarding 

week, the L&D team as they deliver the orientation and I will need their help to 

coordinate the schedule to include IT orientation training, and the room scheduling team 

who manage all the training rooms and labs, so that I can book rooms for the training. 

The IT business application trainers who will be assisting me the implementation 

of the program need to understand that their roles and responsibilities, which include 

deliver of training and being available as a support person for the learner throughout their 

nine week learning journey. 

Project Evaluation Design and Approach 

The evaluation design and approach used for this project is the Kirkpatrick four 

level evaluation model, as it incorporates both summative and formative evaluation. The 

new Kirkpatrick model proposes to start the project with business value in mind and to 

start with level fours results, which is the Return of Expectation (ROE) considered as the 
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ultimate indicator of value (Kirkpatrick & Kirkpatrick, 2009; Kirkpatrick & Kirkpatrick, 

2013). The following are the four levels (Kirkpatrick et al, 2009): 

Level 4: Results. 

Degree to which the targeted outcomes are achieved, as a result of the learning 

events and reinforcement. 

Level 3: Behaviour 

Degree to which learners apply what they learned back on the job, which is 

transfer of learning. 

Level 2: Learning 

Degree to which the learners acquire the intended knowledge, skills, and attitudes 

based on their participation in learning. 

Level 1: Reaction 

Degree to which learners react favorably to learning event. 

The Kirkpatrick Four Levels Applied To The Project 

Level 4 (ROE). Hospital employees successfully complete the hospital IT 

applications training within the specified time frame which is from week six to week 

eight and are equipped to use the various applications in the hospital. 

Metrics:  

a) Number of training hours will be tracked for each employee.  

b) Number of IT complaints related to lack of skills or knowledge will be tracked 

during the mock operations period 

Level 3. Hospital employees apply the basic IT skills learned during the hospital 
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IT applications training. 

Metrics: 

a) Observation of employees as they apply their skills in IT applications training 

b) Feedback from trainers who provide training on IT applications on hospital 

employees’ performance during the training. Example: Did they find any 

employee struggling with the basic skills and whether they had to spend extra 

time teaching the basic skills. 

Level 2. Hospital employees acquire the basic IT skills, knowledge, and attitude.  

Metrics: 

a) Scenario based tasks to check the skills 

b) Hands on activity  

c) Observation of skills in the class 

Level 1. Hospital employees are satisfied with the classroom and online learning. 

Metrics: 

a) Survey  

b) Face to face discussions 

The results will be analyzed and summarized to measure the effectiveness of the 

project and will also be used to make any required changes in the curriculum or the 

methodology of teaching and learning. The results will be shared with the stakeholders. 
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Project Implications 

Social Change Implications 

Hospitals are increasingly using IT applications for automating each and every 

operation within the health care system. Health care workers are expected to have 

computer skills to effectively and safely use these systems. IT systems vary from hospital 

to hospital and health care workers are expected to adapt and learn the new systems in a 

limited period of time. Health care workers, when they are diverse in terms of education, 

years of experience in hospital setting, and skills with use of computers it becomes 

challenging for them to adapt to new IT applications and learn new skills. 

A project like this which assesses their basic computer skills when they join an 

organization as new employee and provides basic computer skills training accordingly 

will prepare them to learn new IT applications and adapt easily to new systems and 

environment. 

Implications to Local Stakeholders 

Equipping new employees with basic computer skills enables them to learn new 

skills and navigate the day to day functions at the workplace. Prepping the new 

employees with basic computer skills also eases the effort required by the IT trainers to 

train the employees in hospital wide IT applications. Most of the hospital applications 

training are outsourced to the vendor who supplies the applications and if the basic 

computer skills training if developed in-house and incorporated into the new employee 

orientation program can save resources like trainers, time required for training, and cost. 

If this project is successful, other hospitals in the region which are in the project phase or 
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are in the process of digitalizing their operations can replicate the same approach to 

assess and train their staff.  

Conclusion 

In this section the project design with its overall goals and outcomes was 

described. A project implementation plan was detailed based on literature search and 

learning theories which included assessing basic computer skills using an actual skills test 

and providing basic computer skills training to employees based on their present skill 

level. Supports and barriers anticipated in the implementation of the project were 

discussed. Key stakeholders, social change implications, and implications for local 

stakeholders were also discussed. In section 4, the study’s strengths, limitations, and 

implications for further research will be addressed. It will also include an analysis of 

what I learned about scholarship, project development, evaluation, and about leadership 

and change. 
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Section 4: Reflections and Conclusions 

Introduction 

The purpose of this study was to find an accurate tool to assess basic computer 

skills in employees in a hospital still in the preoperational phase and which is aimed to be 

the first fully digitalized hospital in the region. The data collected through quantitative 

means revealed that an actual skills test was a reliable tool to assess the basic computer 

skills in hospital employees. The study also identified areas where there was a skill gap in 

basic computer skills amongst hospital employees. The project was aimed at bridging this 

gap in basic computer skills by developing an IT orientation curriculum. In this section, 

the project’s strengths and recommendation for identified limitations will be discussed. 

This section will also include insight into my learning journey during this research 

project and what I learned about scholarship, leadership and change, and project 

development and evaluation. This section will also include my reflections and analysis of 

being a scholar, practitioner, and project developer. The section concludes with the 

project’s implications, applications, and direction for future research. 

Project Strengths 

The project was developed based on data gathered from the research and that is 

one of the foremost strength of the project. Another strength of the project is that it was 

incorporated into the regular orientation schedule of new employees after collaborating 

with respective stakeholders, which led to better and effective utilization of resources like 

time, space for training, and trainers.  
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Adult learners are active agents in planning and executing their learning and they 

value immediately relevant and problem solving based learning (Knowles, Holton, & 

Swanson, as cited in Chen, 2014). The strength of the project also lies on the framework 

of learning theories it is based on, which makes the IT orientation very relevant to the 

employees. The basic computer skills are taught in such a way that the skills are 

incorporated into teaching computer skills that new employees will need to function on a 

day-to-day basis at work. For example, the IT orientation Level 1 is called tools to 

succeed. In this manner, the employees will find it relevant and will be more accepting to 

learn computer skills. 

The scaffolding provided in in the form of trainers, IT help desk personnel, and 

other fellow employees provides the learners with adequate support to ask questions and 

learn from collaboration. The blended format of the curriculum allows for greater 

flexibility and control over learning for the learners who are in their orientation phase and 

undergoing various other trainings at the same time. It sets the stage for employees to be 

self-directed in their learning journey. 

Project Limitations 

There are a couple of limitations to this project. As the hospital is in 

preoperational phase, the employees are currently using various devices such as tablets, 

laptops, and some desktops, which makes it a bit challenging for the trainers to cater to 

individual learners’ needs; during training the lab has desktops set up, which allows for 

some uniformity. The small study sample size makes generalizability difficult in the use 

of actual skills test to assess basic computer skills. Another perceived limitation is related 
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to the timing of the IT orientation, as to the possibility of employees getting cognitively 

overloaded with all the information they receive during the orientation phase. 

Recommendations for Alternative Approaches 

This study was done to address a local problem as employees were onboarded 

from diverse backgrounds and it was noticed they had varied IT skills, which was of 

concern as they had to be trained on various hospital IT applications within a fixed time 

frame prior to getting operational. The study focused on finding an appropriate tool to 

assess basic computer skills and the project aimed at filling in the skills gaps identified 

during the assessment of basic computer skills.  

One of the recommendations is that the assessment of basic computer skills be 

done during the interview process itself, which will help to screen candidates with 

required skills. It will also allow recruiters to counsel candidates as to what skills are 

expected from them and will allow candidates to brush up skills as they go through the 

hiring process. This will allow for training resources to be utilized in a more efficient 

manner. 

Scholarship 

When I started on this journey, it was very daunting as I was working in a hospital 

that was still in a project phase, far from being preoperational, and I had to choose a 

problem related to the workplace. I was one amongst the first 100 employees who were 

onboard at that time. Being a part of the Learning and Development Team helped as I 

was involved in orientation of new employees and I was collaborating with various 

departments, divisions, and institutes to understand their training needs. As I interacted 
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with people from the IT and informatics department, I realized that the biggest concern 

they had was around training new employees on all the IT applications that will be used 

in the hospital. I started delving deeper into this problem and decided to explore it further 

by going over the vast literature available and critiquing research articles, which led to 

my research. 

Writing the proposal and going through the iterative process with my chair was a 

great learning curve for me. Along with scholarly writing, I had to learn to say a story 

with a flow, which was a bit challenging in the beginning. Performing a literature review 

for the research study and for the project enriched my knowledge about the problem and 

about various learning theories and teaching learning methodologies. While deciding on 

the research methodology, sample size, and applying statistics for data analysis I learned 

that reading and critiquing similar studies through literature search helped, but what 

helped tremendously were the discussions with colleagues and friends who directed me to 

think and probe further. 

Though challenging and frustrating at times, I gained tremendous knowledge 

about research and project development and have gained confidence in applying my skills 

as a researcher. I am more confident now to explore, identify problems, and do research 

and find solutions. Going through this doctoral program has made me more receptive to 

the needs of adult learners and how I can effectively facilitate their learning. This 

doctoral journey has made me engage with critical problems faced by the teaching 

learning communities and work towards bringing about social change. 
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Project Development and Evaluation 

When I started with the project development I was feeling lost, as I am not an IT 

trainer. An extensive literature search directed me to develop the project based on a 

framework of learning theories. I wanted to know what would be the best teaching 

methodology for teaching computer skills, so I talked to IT trainers and all of them had 

the same approach, which was demonstrating a skill and asking learners for return 

demonstration. This approach was not new to me coming from a nursing background. It 

was an enlightening learning journey for me. I developed an IT orientation curriculum, 

which I would not have done otherwise. Through this project development, I learned that 

if you take a systematic approach and have a theoretical framework you can develop any 

project. I decided to apply Kirkpatrick four levels to evaluate the project as it is an 

amalgamation of formative and summative evaluation. Evaluation of the project will help 

understand how the employees perceive the project and how effective it was in achieving 

the desired outcomes. It will also help measure transfer of skills learned to workplace. 

Leadership and Change 

As the project lead, I collaborated with the key stakeholders and got them 

involved at a very early stage when I started my research. The key to being an effective 

leader is communication and collaboration. Change is always difficult and people tend to 

resist any form of change; nonetheless, what I learned during my project development is 

that the resistance can be managed properly if there is constant communication and 

collaboration, and more importantly when a project plan is based on hard facts and data. 

If value is created before it is being demonstrated, then it is not difficult to get a buy-in 
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from the stakeholders. I showed the stakeholders the value of the project and how it 

supports the business needs and I had their full support. 

Analysis of Self as Scholar 

When I started my doctoral program with Walden, I found it very challenging to 

write my first scholarly paper. The last research paper I wrote was 10 years back for my 

Masters dissertation, which I had done in India. What was expected of me from Walden 

was way beyond what I was used to. It took me 2-3 days to write a paper of 300 words. 

I took help from the Walden writing center and got constructive feedback, which I 

worked on diligently. I learned how to paraphrase, avoid plagiarism, and cite articles 

using the APA format. Videos from the Walden Library helped me perform proper 

literature search and use tools to organize my references and articles, so I effectively 

utilized my time. I am more confident now as compared to when I started my program 

with Walden and able to help other colleagues who are on their Masters or Doctoral 

journey. 

I learned how to search the vast available literature for evidence based literature. I 

got to apply analytical and critical thinking while critiquing researches done previously 

and learn from them.  

Analysis of Self as Practitioner 

I have been in the education field for a while now and this experience has made 

me grow into a more aware practitioner. I am able to see a bigger picture and what I can 

do for the business as a practitioner. Working side by side my doctoral degree has been 

challenging, but a very rewarding experience. I could apply what I learned during my 
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doctoral course at my workplace and vice versa. As an educator I know how important it 

is to transfer what you learned into practice, and I am empowered by the knowledge that I 

am able to do that. I am always looking at ways to improve the current learning programs 

that I am involved in. I am also able to take on the role of a consultant advising other 

departments and divisions on identifying their learning needs and filling in those gaps. 

Analysis of Self as Project Developer 

In my present workplace and in the past I have been part of various projects, but 

this was the first time that I was totally in charge of the project from scratch. It was a very 

humbling experience for me, I realized how important it was for me to collaborate and 

communicate clearly with all stakeholders. There were so many complex pieces to the 

puzzle and it has made me appreciate people around me. I remember the time I had to 

present to the CEO, I was all nerves and I was advised by the CHRO that I need to limit 

my whole presentation to just three slides and I had just 15 minutes to put my idea across.  

This was a learning experience for me, where I learned to present information 

which was brief and created an impact. 

Reflection on the Importance of the Work and Lessons Learned 

Overall the doctoral journey has been a very enriching and enlightening learning 

experience. I have grown spiritually and intellectually, and am more confident as a 

scholar, practitioner, and a leader. I am ready to take on more responsibilities and face 

challenging situations and am not afraid to stretch my limits. More importantly I have 

learned how to create business impact and a social change.  
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I have had very challenging time trying to get approvals from organizations to do 

my data collection as our hospital was still in project phase. I had to wait a while to get 

the permission to do the data collection in my place of work. Even when I started data 

collection, though the participants were enthusiastic and supportive, I did not get the 

response I expected. I realize and am aware of the challenges when a hospital is in project 

phase and employees are busy getting it into operational phase. Throughout this journey, 

I learned the importance of persevering and not letting go of my goal, and the importance 

of people around you such as family, friends, colleagues, classmates, and more 

importantly the chair who supported and motivated me in this journey.  

Implications, Applications, and Directions for Future Research 

Lack of basic computer skills has been identified as one of the main reason for 

poor adoption of EHR in health care. Assessing the basic computer skills and providing 

initial training on improving basic skills would lead to improved confidence and ease in 

learning more advanced skills required for applications related to EHR and better 

adaptation to change and acceptance of IT applications. 

Proper training and robust support systems and scaffolds leads to better utilization 

of training resources and better acceptance of systems. The small sample size than what 

was intended limits the generalizability of the results. In future, a research with a larger 

sample size would be recommended. While doing this research one of things which 

intrigued me was the impact of culture in doing a self-assessment, as I had a varied 

multicultural group. Therefore, a future research on how culture impacts a self- 
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assessment score would be of value in a world where workplace demographic is 

becoming more varied and multicultural. 

Conclusion 

Health care organizations throughout UAE have started on a journey of 

integrating electronic health care. The delivery of safe and effective health care depends 

on employees’ ability to effectively use all these different electronic applications. The 

transition to these electronic health care systems requires employees to adapt to these 

new systems and learn new skills. Having basic computer skills makes learning new 

skills easier. The study has explored appropriate tool for assessing basic computer 

literacy and developed a curriculum to fill the gaps identified during assessment.  

The doctoral journey has been a learning journey where I got to stretch my 

capabilities which have transformed me into a better human being, a scholar, practitioner, 

a more effective leader and change agent. When I work on projects at workplace, I think 

of how it will impact to bring about a social change.  
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Appendix A: The Project 

Week 1: Assessment of basic computer skills using actual skills test 

Week 2: Core IT Orientation Level 1 (Duration 2 hour  includes 15 min Break) 

This is mandatory for all employees and this is scheduled on week two of the orientation 

program. 

Objective: 

To orient the new employees to the IT applications needed for day to day business 

functioning. This includes: 

 How to login to the computer using username and password 

 Using Microsoft Outlook and Microsoft Lync for communication 

 Accessing organization XXX’s intranet and searching for information 

 Accessing the virtual private network (VPN) 

 Print using the follow-me printing using the ID badge 

 Access the learning management system (LMS) 

Checklist for trainers and facilitators: 

 Prior to the class, make sure the computers in the training lab have Internet access 

 Ensure all the new employees are in the global address list and have been 

assigned username and password 

 Ensure IT help is available during the class to address any technical issues which 

may arise 

 Check if the audio visual equipment are functioning 
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IT Orientation Level One Manual 

Introduction: 

Slide 1 

 

One way to become successful at work  is to know what are the tools that you would need 

and how you will use them effectively. 

So today, I will introduce you to the basic applications that you will use on a daily basis. 

In this way, you will become more productive and effective in your job. 

This training is composed of two things – a slide presentation, where I’ll be explaining 

the concept and the steps on how to use an application and hands-on activities so you 

could practice. 

Just observe as I demonstrate the steps, next you will do the steps along with me and then 

lastly you will do the steps independently. 
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Computer Login (15 min) : 

Slide 2 

 

Demonstrate and observe the participants as they login to the computers. 

Changing Your Password 

 

Please ensure to change the default password. The new password has to be 8 characters 

with a combination of uppercase, lowercase, number and special characters. 

 

 

 

 

 

 

 

Task Steps: 

 Press CTRL + ALT + DELETE keys simultaneously. 

 Click the CHANGE A PASSWORD option. 
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 Enter your OLD PASSWORD. 

 Enter your NEW PASSWORD. 

 Re-enter your NEW PASSWORD to confirm. 

 Click the arrow button or press enter to login. 
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Microsoft Outlook Basics (40 min) 

Objectives: 

We use Microsoft Outlook for e-mails and meeting requests.  

By end of this session, you will be able to: 

 Find fellow employees and their contact details through address book 

 Book a meeting request and a room through calendar 

 Archive and search e-mails using the Enterprise Vault 

 Add  signature to your e-mail.  

Slide 3 

 

 

Slide 4 
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Scenario 1: Search for your name and view your contact details. 

 

Task Steps 

 From your desktop, click the Start button. 

 Type “Outlook” in the search field. 

 Select Microsoft Outlook 2010.  

 Click the Address book button. 

 Type your name on the search field and view your contact details. 

 Write down your contact details. 

 Title:                   __________________  

 Business Phone: __________________  

 Location:           ___________________ 

 Department:      ___________________ 
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Scenario 2: Create a meeting request with room booking and send it to the person 

sitting next to you 

 

 

Task 1: Creating a Meeting Request with Room Booking 

 From Outlook, click Calendar and select New Meeting. 

 Click the To button and type the name of the person that you wish to 

invite. 

 Type the Subject of the meeting. For example: Budget Allocation 

 Specify the start time and end time of the meeting. 

 Click Show a room List and select the location where you want your 

meeting to be held. In this example, we will choose Baniyas Meeting 

Rooms  
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 Select an available meeting room. (This will vary depending on the 

availability of the rooms) 

 Type the agenda for the meeting. For example: Review and finalize 

budget for first quarter of 2015 

 Send the meeting invite by clicking the Send button. 

 

Task 2: Accepting a Meeting Request 

 Open the meeting request from your inbox. 

 Send the meeting invite by clicking the Send button. 

 Click Accept. 

Task 3: Cancelling a Meeting Request 

 From the Calendar screen, select the meeting that you want to cancel. 

 Click Cancel Meeting. 

 Click Send Cancellation 
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Scenario 3: Archive any e-mail by using the Enterprise Vault 

 

 

Task 1: Archive any e-mail from your inbox. 

 Click the Enterprise Vault menu. 

 Select the e-mail that you want to archive. 

 Click Store and then Store Selected Items. 

 Click Synchronize to refresh and move your archived e-mails into your Vault. 

Note: Synchronization might take time. Your e-mail might be moved instantly or 

sometimes the next day depending on the network speed or server traffic. 
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Task 2: Search e-mails in your vault 

 Click the Enterprise Vault menu. 

 Select your Vault folder. 

 Click Search Vaults to search any item saved in your vault. 

 

Scenario 4: Add  signature  

A signature can automatically be added to outgoing messages, or you can manually add 

the signature to only the messages that you choose 

 

Note: 

Use plain text Arial 10 Regular, only your name should be bold. 

Do not use more than 4 lines. 

Use | to separate text.   

Below is a template that you can use in your e-mail signature, replacing the text in red 

 

 

First Last Name | Title | Name of Organization 

Office: +971 2 Your Number | Mobile: +971 Your Number | Email: [make sure it is 
hyperlinked] 
Website: www.XXXXXX.com  [make sure it is hyperlinked] 

  

Logo of organization 

http://www.xxxxxx.com/
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Microsoft Lync (25 min) 

Objectives 

Microsoft Lync is an instant messaging system. Through this you will be able to 

communicate with others easily. 

By end of this lesson, you will be able to: 

 Send instant message to other employee. 

 Set availability options. 

 Add a contact. 

 Share a file and desktop to someone. 

Slide 5 

 

Slide 6 
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Scenario 1: Explore the basic functions of Lync -  such as availability menu, status 

update,  messaging, file and desktop sharing. 

 

Task 1: Update your status and availability option 

 Set your status by clicking Status Update and type “Attending IT Orientation”. 

 Click the Availability Menu and select “Do Not Disturb”. 

Task 2: Send an instant message, share a file and desktop with someone 

 To send a message, double-click the name of the employee and type your 

message. Press enter. 

 Drag and drop any file to the message box to send a file. 

 Click Share and select Desktop. 
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Organizations Intranet – Connect (20 min) 

Objectives 

Connect is an  intranet site. This is your default web page. You can use this to access 

several key information such as – Policies and Procedures, Health Headlines, Corporate 

Discounts, Employee Celebrations, New Employee Portal and etc.  

By end of this lesson, you will be able to view and explore the following sections: 

 Contact list  

 Quick Links  

 Employee Experience  

 Policies and Procedures 

Slide 7 
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Slide 8 

 

 

Scenario 1: Explore different sections and links. 
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Task 1: View Contact List 

 Open the Internet Explorer to access Connect ( Intranet). Connect is the default 

web page of your Internet browser. 

 Go to the Contact List section. 

 Write down the contact information for: 

 Reception  _________________________________ 

 IT Service desk _________________________________ 

 Protective Services _________________________________ 

Task 2: Search for non-smoking policy  

 From the home page of Connect, click Policies and Procedures. 

 On the search field, type “non-smoking”.  

 Search results will appear, click “Non-Smoking Policy.docx”. 

 Close the document after reading the policy.  

Slide 9 
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Hands-On Activity 1 (10 min)                                                 60 Marks 

1. Open your Microsoft Outlook and click Address Book. 

2. Search for David Oars and write down his contact details. 

Title:    __________________________ 

Business Phone:  __________________________ 

Location:   __________________________ 

Department:  __________________________ 

3. Open your Microsoft Lync. What is the current Lync status of your 

manager? 

A. Available 

B. Offline 

C. Busy 

D. None of the above 

4. Access the  Intranet site and go to the Contact List section. What is the IT 

Service Desk contact number? _______________________ 

5. On  Intranet Site Connect, go to Policies and Procedures. What are the 3 

links available under “Getting Started with Policies and Procedures”. 

A. _________________________________________ 

B. _________________________________________ 

C. _________________________________________ 

6. Search and access the Non-smoking Policy. Fill-in the blanks below: 

Target Group:   ________________________ 

             Policy Number: ________________________ 

             Date of Issue:   ________________________ 
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Virtual Private Network (VPN) (15 min) 

VPN allows you to connect to the organizations network from home or outside the 

organization 

Connecting to VPN may vary depending on your device 

Objective 

By end of this lesson, you will be able to: 

 Connect to VPN anywhere outside the organization 

 

Slide 10 

 

 

Slide 11 
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Tablet Users 

 

 

 

Task Steps:  

 

 From your Start Screen, open the Desktop tile. 

 On your taskbar, click the Network icon and select  VPN. 

 Click Connect. 

 The sign-in screen will appear. Enter your windows username with domain name 

and password 
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For Laptops: 

 

 

 

Task Steps:  

 Ensure to have an Internet connection. 

 On your taskbar, click the Network icon and select VPN. 

 Click Connect. 

 The sign-in screen will appear. Leave the fields blank 

 Click Connect. 
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Follow Me Printing (20 min) 

With this service you can now print to the single Follow ME printer and collect your print 

job(s) on any multifunction printer by simply walking up to it and tapping your  ID card 

on its card reader and selecting what to print!  This service is more secure and will help 

the organization shrink its carbon footprint by saving paper and toner. To use this service 

please follow the instructions of the guide below. 

Objective: 

By end of this lesson, you will be able to: 

 Print securely using follow me print 

Slide 12 

 

 

 

Slide 13 

 



106 

 

Scenario 1: Enroll your Smart Card to Follow ME Printing  

 

 

You will be prompted to enter your windows user name and password 
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Scenario 2: Start using the Follow ME Printing.  

 

Task1: Sending print jobs to any printer. 

Below are the printers that you can use for Follow ME Printing, select the printer 

depending on your location 

 

 

Task2:Using Follow ME Printing service: 

After sending the job to the Printer, the job will be held at the secure print queue. Go to 

the printer you would like to receive the job from and touch the Follow ME button. 

When prompted to enter your domain credentials, place your badge at the smart card 

reader. You will be then logged in to your Follow ME menu. 
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Learning Management System (LMS) (30 min)  

Objectives 

The organization supports comprehensive development by providing individual 

employees with a one-stop shop for courses and other learning opportunities.  

From the LMS you can search a catalogue to see what learning is available, review what 

learning has been assigned, register, view training history, or print training records.  

This means all your training needs, such as courses, conferences, workshops plus your 

training records and certificates are all located in a central application LMS.  

 

By end of this lesson, you will be able to: 

 Access the LMS website 

 Navigate the LMS home page and catalogue 

 Search and Launch an e-Learning course 

 Search and register for an Instructor Led Training ILT course 

 Cancel a course registration 

 View and print certificate of completion  

 Upload external trainings  

Slide 14 
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Slide 15 

 

 

 

 

 

 

 

Scenario 1: Access the LMS website. 

Task Steps 

To open the LMS site:  

  Open your web browser, click Favorites button 

  Click the organization folder, then HR, and select LMS 
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Scenario 2: Overview of LMS Welcome Screen, To Do List, and Catalogue 

sections: 

 

Task Steps 

This is what you will see when LMS Home page opens: The page will contain 2 parts:  

 The TO DO section allows you to see all your newly assigned activities and the 

ones that are still in progress.  

 The Catalogue is where you can browse all available learning activities from 

Instructor Led Training Courses, to e-Learning videos according to your interests 

and needs 
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Scenario 3: Search and launch an e-learning activity 

 

Task Steps 

You can find a course by: 

 Using the Catalogue as mentioned above, or 

 Using the Search field located at the top left corner of the window. 

For example if you want to know how to approve your timecard on Mawared time and 

attendance: 

 Click in the Search field box and type “Approve Timecard” 

 How many searches have you got? ______________ 

 Click the Start button to start your activity.  

Note: (Clicking on the Activity Name Link will not start an activity, but will open a pop 

up window to show more details about the activity). If you click the name Link, Click the 

Close Link at the Top/middle corner of the screen to go back to the previous screen) 

 After you have been through the learning activity, write down the steps on how to 

approve your timecard: 

o __________________________________________________________ 

o __________________________________________________________ 

 Close the activity, and click OK. You will be then directed to the Training 

Schedule window, where you will find your incomplete activities so that you can finish 

what you haven’t completed yet. 
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Scenario 5: Cancel a course registration 
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Task Steps 

 From the LMS Home page, click the Quick Links button to the left of your 

screen. 

 Then select Training Schedule. A list of all incomplete activities will show, 

activities that you have already started but didn’t complete yet. You can either 

click the Start button to continue this activity, or you can cancel it. 

 To cancel an incomplete activity, select the Tick box next to the activity you want 

to cancel then click the Cancel Registration Go Button. 

 You will get a confirmation, click Cancel Marked.  

 

Slide 16 
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Hands-On Activity 2: LMS (10 min)     80 Marks 

1. Access Learning Management System (LMS) through your Favorites. 

2. On the home page on the top of your screen, list down the tabs that you can see. 

A. _______________________________ 

B. _______________________________ 

C. _______________________________ 

3. List down the courses available under your TO DO list. 

A. _________________________________________________________ 

B. _________________________________________________________ 

C. _________________________________________________________ 

D.  _________________________________________________________ 

4. Go to CATALOGUE section and select COMPUTER SYTEMS EDUCATION.  

What’s the total number of courses or records on this category? ______________ 

5. Search for the Performance Management Cycle course and then click START. 

There are two modules in this course: 

___________________________ and __________________________________. 

6. Close the course by clicking the EXIT button, and then Exit now. 

7. Upon closing the course, the next screen that you will see is the Learning Activity 

Progress Detail page. What’s the topic status of the course that you recently 

opened? ______________________ 

8. Go to LEARNER  LEARN  LEARNING ACTIVITY REPORTS  

TRAINING TRANSCRIPTS. What can you see on this page? Have you 

completed any learning activity?  Yes   No 
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Week 3: IT Orientation Level 2  (3 hrs. including 15 min break) 

This is mandatory for all employees who fall under the beginner and intermediate 

category and this is scheduled on week three of the orientation program. 

Objective: 

By end of this orientation , participants will be able to: 

 Perform Internet search 

 Perform basic functions of Microsoft Word 

 Perform basic functions of Microsoft Excel 

IT Orientation Level Two Manual 

Introduction 

This is level 2 of the orientation and we will be learning the basics of utilizing the 

Internet for searching information, word and Excel. 

Internet Search (20 mins) 

Objective:  

By end of this lesson, the participant will be able to: 

 Launch Internet explorer 

 Type an URL 

 Search for information using google search engine 
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Slide 1 

 

 

Slide 2 
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Scenario 1: Launch Internet Explorer 

Internet Explorer is the default web browser for windows computers and tablets 

 

Task Steps: 

To launch the Internet Explorer 

 Click on the start which is the Microsoft Windows icon 

 Next click on the Internet Explorer icon 

Scenario 2: Launch the Internet Explorer from task bar 
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Task Steps: 

 Click on the Internet Explorer from the task bar 

 

Scenario 3: To navigate to a website with Internet Explorer 

 

  

Task steps: 

 Type a web address, also known as a URL, into the address bar, then press Enter. 

URL http://www.jointcommissioninternational.org 
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Scenario 4: Search the web 

 

Task Steps: 

 Click on the address bar and type in search word “ infection control” and click 

enter 

Note: Internet Explorer uses the Bing search engine by default. 

Scenario 5: Using a different search engine like Google or Yahoo 
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Task Steps: 

 Click on the add button, which will open up the Internet Explorer Gallery 

and you can add different search engines or you can type the URL 

http://www.google.com or http://www.yahoo.com which will open up the home 

page 

Scenario 5: Using the navigation buttons 

Internet Explorer uses four buttons for navigation: the Back, Forward, Refresh, and 

Home buttons. 

 

Task Steps: 

 Access couple of websites for infection control 

 Next use the back and forward button to move through recently browsed pages 

 Use the refresh button 

 Click on the home button to get back to the home page 

http://www.google.com/
http://www.yahoo.com/
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Slide 3 

 

Hand On Activity 1 : Internet Search  (10 mins)   70 Marks 

1. Launch the Internet Explorer from the ‘Start Menu’ and close 

2. Launch the Internet Explorer from the task bar 

3. In the address bar type in the following URL http://www.instructionaldesign.org 

and then close the web browser 

4. Launch the Internet Explorer and in the address bar type in search word ‘holiday 

destinations’ 

5. Browse the first  four websites under holiday destinations 

6. Use the back and forward button to move through recently browsed pages 

7. Use the refresh button and then click home button to get back to home page  

http://www.instructionaldesign.org/
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Microsoft Word (45 min) 

Introduction: Word 2010 is a word processor that allows you to create various types of 

documents such as letters, papers, and flyers. In this lesson, you will be introduced to the 

Ribbon , and  learn how to create new documents, save documents, and print the 

documents. 

Objectives: 

By the end of the lesson participants will be able to: 

 Open a new word document 

 Type text in the word document 

 Save the new document and name the document  

 Print a word document 

 Close the word application 

Slide 4 
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Slide 5 

 

Scenario 1: Open Microsoft Word application 

 

Task Steps: 

 Click on the “Start Menu” 

 Next click on “All Programs” 

 Next click on “Microsoft office” 

 Lastly click on “Microsoft Word” 
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Scenario 2: Getting to know the “Ribbon” 

 

Task Steps: 

 Click on the tab ‘page layout’ on the ribbon and List down the 5 groups which 

you see: 

1. ___________________________  

2. ___________________________ 

3. ___________________________ 

4. ___________________________ 

5. ___________________________ 
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Scenario 3: Opening a new word document 

 

 

Task Steps: 

 After opening the word application from the start menu, click on File  

 Next click New 

 Select  Blank Document  under Available Templates. It will be highlighted by 

default. 

 Lastly click create 
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Scenario 4 : To open an existing document 

 

Task steps: 

 Click File tab 

 Next click on Open 

 From the dialogue box which opens up, choose the document you want to open 

Note: From the File tab, if you select Recent you can view the recent documents you 

have worked on 

Scenario 5: Typing text  including how to insert, delete, select, copy, cut, paste, and 

drag and drop text. 

5A: To insert text 
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Task steps: 

 Move your mouse to the location where you want text to appear in the document. 

 Click the mouse. The insertion point appears. 

 Type the below text. 

 

In addition to using your cover letter to expand on your key qualifications, you can also 

address unique topics, such as employment gaps on your resume, willingness to 

relocation or the desire for a career change. 

 

5B: To delete text 

Task steps: 

 Place the insertion point next to the text you want to delete. 

 Press the Backspace key on your keyboard to delete text to the left of the insertion 

point. 

 Press the Delete key on your keyboard to delete text to the right of the insertion 

point. 

 

5C: To select text 

 

Task Steps: 

 Place the insertion point next to the text you want to select. 

 Click the mouse. While holding it down, drag your mouse over the text to select 

it. 

 Release the mouse button. You have selected the text. A highlighted box will 

appear over the selected text. 
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5D: To copy and paste text 

 

Task steps: 

 Select the text you want to copy. 

 Click the Copy command on the Home tab. You can also right-click your mouse 

and select Copy   

 Place your insertion point where you want the text to appear. 

 Click the Paste command on the Home tab or right click the mouse and select 

paste. The text will appear. 

5E: To cut and paste text 
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Task steps: 

 Select the text you want to copy. 

 Click the Cut command on the Home tab. You can also right-click the 

document and select Cut. 

 Place your insertion point where you want the text to appear. 

 Click the Paste command on the Home tab. The text will appear. 

 

5F: To drag and drop text  

 

Task Steps: 

 Select the text you want to copy. 

 Right Click and drag the text to the location where you want it to appear. The 

cursor will have a rectangle under it to indicate that you are moving text. 

 Release the mouse button, and the text will appear. 

 

Slide 6 



130 

 

Hands on Activity 2 : Word       80 Marks 

1. Open a new word document from the start menu 

2. Type the following text : 

“If there’s a need to relocate, use the cover letter as an opportunity to point 

out that you’re open to relocation, especially if you already have a 

connection to the area through family or school,” Wittman said. “This will 

help alleviate any apprehensions that a hiring manager has about hiring 

someone who is new to the area. If you’re changing careers or industries, 

relate examples of your experience that will help you prepare [for the 

change] and are relevant to the new job.”  

3. Select a sentence  

4. Copy and Paste to another location on the same document 

5. Select another sentence 

6. Cut and Paste to another location on the same document 

7. Select another sentence  

8. Drag and drop to another location 

 



131 

 

Scenario 6: Formatting the text  

6A: Changing Font Size 

 

 

Task Steps: 

 Select the text you want to modify. 

 Click the drop-down arrow next to the Font Size box on the Home tab. A drop-

down menu appears. 

 Select the desired font size from the menu. Alternatively, you can type the value 

you want and then press Enter on your keyboard. 

 

6B: Changing the Font 
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Task Steps: 

 Select the text you want to modify. 

 Click the drop-down arrow next to the Font box on the Home tab. The Font drop-

down menu appears. 

 Move the mouse pointer over the various fonts. A live preview of the font will 

appear in the document. 

 Select the font you want to use. The font will change in the document 

 

6C: Changing Font Color 

 

Task Steps: 

 Select the text you want to modify. 

 Click the Font Color drop-down arrow on the Home tab. The Font Color menu 

appears. 

 Move the mouse pointer over the various font colors. A live preview of the color 

will appear in the document. 

 Select the font color you want to use. The font color will change in the document 
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6D: Highlighting the Text 

 

Task steps: 

 Select the text you want to highlight 

 From the Home tab, click the Text Highlight Color drop-down arrow. The 

Highlight Color menu appears. 

 Select the desired highlight color. 

 Select the text you want to modify. It will then be highlighted. 

6E: To use bold, italic, and underline commands 
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Task Steps: 

 Select the text you want to modify. 

 Click the Bold, Italic, or Underline command in the Font group on the Home 

tab. 

6F: To Change Text Case 

 

 

Task Steps: 

 Select the text you want to modify. 

 Click the Change Case command in the Font group on the Home tab. 

 Select the desired case option from the list 
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6G: To Change Text Alignment 

 

Task Steps: 

 Select the text you want to modify. 

 Select one of the four alignment options from the Paragraph group on the Home 

tab. 

a) Align Text Left: Aligns all selected text to the left margin 

b) Center: Aligns text an equal distance from the left and right margins 

c) Align Text Right: Aligns all selected text to the right margin 

Justify: Aligns text equally on both sides and lines up equally to the right and left 

margins; used by many newspapers and magazines 
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Scenario 7: To Save Word Document 

 

Task Steps: 

 Click the File tab. 

 Select Save As. 

 The Save As dialog box will appear. Select the location where you want to save 

the document. 

 Enter a name for the document.  

 Then click Save 
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Scenario 8: To Print a Document 

 

Task Steps: 

 Click the File tab  

 Select Print. The Print pane appears, with the print settings on the left and the 

Preview on the right. 

 Go to the Settings. 

 If you only want to print certain pages, you can type a range of pages. Otherwise, 

select Print All Pages. 

 Select the number of copies. 

 Select a printer from the drop-down list. 

 Click the Print button. 
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Slide 7 

 

 

Hands On Activity 3: Word      80 Marks 

1. Open a new document from Start menu 

2. Type the following text: 

“There’s no doubt that your résumé is one of the most important and powerful tools for 

communicating your qualifications and experience to a hiring manager. Just a quick 

glance at this one- or two-page document can tell someone whether you have the 

necessary background and related skillset to do the job well.” 

3. Select a sentence and change font size to 14 

4. Next change the font style to Century Gothic 

5. Change font color to green 

6. Lastly align the whole text to center 

7. Print the document 

8. Save the document on desktop and name the document “Trial” 
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Microsoft Excel (45 min) 

Excel is a spreadsheet program that allows you to store, organize, and analyze 

information. 

Objectives: 

By end of this lesson, participants will be able to: 

 Open a workbook on Excel 

 Enter data in cells 

 Format cells 

 Save an Excel workbook/worksheet 

 Print an Excel worksheet 

Note: You will learn more skills in Track 1 and Track 2 

Slide 8 
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Slide 9 

 

Scenario 1: Open Microsoft Excel Application 
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Task Steps: 

 Click on the “Start Menu” 

 Next click on “All Programs” 

 Next click on “Microsoft office” 

 Lastly click on “Microsoft Excel” 

Scenario 2: Open a new workbook in Excel 

 

Task Steps: 

 Select File tab 

 Next select New 

 Select Blank workbook, which is highlighted by default 

 Lastly click Create 
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Scenario 3:  The Ribbon  

 

Task Steps: 

Open the Tab Insert and list down all the 8 groups which are present 

1. ___________________ 

2. ___________________ 

3. ___________________ 

4. ___________________ 

5. ___________________ 

6. ___________________ 

7. ___________________ 

8. ___________________ 
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Scenario 4: Enter data in a cell  

4A: The Cell 

 

 Each rectangle in a worksheet is called a cell. A cell is the intersection of a row 

and a column. 

 Each cell has a name, or a cell address based on which column and row it 

intersects. The cell address of a selected cell appears in the name box. Here, you 

can see that D 16 is selected. 
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4B: Selecting a cell or multiple cells 

 

Task Steps: 

 Click a cell to select it. When a cell is selected, you will notice that the borders of 

the cell appear bold   and the column heading and row heading of the cell are 

highlighted. 

 Release your mouse. The cell will stay selected until you click another cell in the 

worksheet. 
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Task steps:  

 Click and drag your mouse until all of the adjoining cells you want are 

highlighted 

 Release your mouse. The cells will stay selected until you click another cell in the 

worksheet. 

 

4C: Entering Content in Cell 

 

Task Steps: 

 Click a cell to select it. 

 Enter content into the selected cell using your keyboard. The content appears in 

the cell and in the formula bar. You can also enter or edit cell content from the 

formula bar. 
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4D: To delete content from cell 

 

Task Steps: 

 Select the cells containing content you want to delete. 

 Click the Clear command on the Ribbon. A dialog box will appear. 

 Select Clear Contents. 

 Note: You can also use your keyboard’s Backspace key to delete content from a 

single cell or the Delete key to delete content from multiple cells. 
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4 E: Deleting Cells 

 

Task Steps: 

 Select the cells you want to delete. 

 Choose the Delete command from the Ribbon. 

 Scenario 5: Formatting the Cells 

 You will learn how to change the color and style of text and cells, align text, and 

apply special formatting to numbers and dates. 
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5A: Changing Font 

 

Task Steps: 

 Select the cells you want to modify. 

 Click the drop-down arrow next to the Font command on the Home tab. The font 

drop-down menu appears. 

 Select the font you want to use. 
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5B: Changing Font Size 

 

Task Steps: 

 Select the cells you want to modify. 

 Click the drop-down arrow next to the font size command on the Home tab. The 

font size drop-down menu appears. 

 Select the font size you want to use. 

5C: Using Bold, Italic and Underline Commands 

 

Task Steps: 

 Select the cells you want to modify. 

 Click the Bold, Italic, or Underline command on the Home tab. 
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5D: Change Font Colour 

 

Task Steps: 

 Select the cells you want to modify. 

 Click the drop-down arrow next to the font colour command on the Home tab. 

The colour menu appears. 

 Select the colour you want 
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5E: Add Border to a Cell 

 

Task Steps: 

 Select the cells you want to modify. 

 Click the drop-down arrow next to the Borders command on the Home tab. The 

border drop-down menu appears. 

 Select Border Style you want 
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5F: Fill Color in a Cell 

 

Task Steps: 

 Select the cells you want to modify. 

 Click the drop-down arrow next to the fill color command on the Home tab. The 

color menu appears. 

 Select the fill color you want to use. 

5G: Changing Text Alignment 

To change horizontal text alignment 

 



153 

 

Task Steps: 

 Select the cells you want to modify. 

 Select one of the three horizontal Alignment commands on the Home tab. 

 Align Text Left: Aligns text to the left of the cell 

 Center: Aligns text to the center of the cell 

 Align Text Right: Aligns text to the right of the cell 

 

To change vertical text alignment 

 

Task Steps: 

 Select the cells you want to modify. 

 Select one of the three vertical Alignment commands on the Home tab. 

 Top Align: Aligns text to the top of the cell 

 Middle Align: Aligns text to the middle of the cell 

 Bottom Align: Aligns text to the bottom of the cell 
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Scenario 6: Saving a Workbook 

 

Task Steps: 

 Click the File tab. 

 Select Save As. 

 The Save As dialog box will appear. Select the location where you want to save 

the workbook. 

 Enter a name for the workbook 

 Click Save. 



155 

 

 

Scenario 7: Printing the Workbook 

 

Task Steps: 

 Click the File tab.  

 Select Print. The Print pane appears, with the print settings on the left and Print 

Preview on the right. 

 Select Settings 

 Select whether you want to print active sheet or the whole workbook 

 Select Printer 

 Select number of copies you want to print 

 Click Print 
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Slide 10 

 

 

Hands on Activity 4: Excel      70 Marks 

1. Open a new Excel workbook  

2. Enter the following data 

a.  

3. Choose Cell A 5 and make it Bold 

4. Choose Cell B1 and C1 and fill color blue 

5. Draw borders for all Cells 

6. Save the workbook in Desktop as Trial 

7. Print the workbook 
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Week 4 – 6:  

Note to Trainers: Assign the following courses on LMS as per the participants’ level of 

IT skills. 

Course Completion Requirements: Participants have to score more than 80% in each 

module to consider it as completed. Participants can attempt the tests multiple times. 

Beginners: Will complete track 1 in LMS, which includes the following: 

 Beginner Skills in Microsoft Word 
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 Beginner Skills in Microsoft Excel 

 

 Intermediate Skills in Microsoft Word 
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 Intermediate Skills in Microsoft Excel 

 

Intermediates: Will complete Track 2 in LMS, which includes: 

 Intermediate Skills in Microsoft Word 
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 Intermediate Skills in Microsoft Excel 

 

 Advanced Skills in Microsoft Word 

  
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 Advanced Skills in Microsoft Excel 

 

Week 6-8: Participants’ will be attending the IT hospital applications training. 

Objective: The employees will get to apply the skills that they learned in week 4-6 

Note for Trainers:  

 Assess transfer of learning by observing how the participants perform in the IT 

applications class 

 For interested participants in the beginner level, you can assign advanced courses 

on LMS 

Week 9: Feedback and Evaluation 

This includes feedback from IT trainers and the survey. 
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Survey: Course Evaluation 

Instructions: Please rate the following statements  

1. I felt the course content was appropriate for my level of understanding  

o strongly agree 

o Agree 

o Neutral 

o Disagree 

o Strongly disagree 

 

 

 

2. I was comfortable with the duration of the program 

o strongly agree 

o Agree 

o Neutral 

o Disagree 

o Strongly disagree 

 

 

3. The activities, exercises, and demonstrations  helped my learning 

o strongly agree 

o Agree 

o Neutral 

o Disagree 

o Strongly disagree 

 

 

4. My learning was enhanced by the experiences shared by the facilitator(s) 

o strongly agree 

o Agree 

o Neutral 

o Disagree 

o Strongly disagree 

 

 

Comments: 

Comments: 

Comments: 

Comments: 



163 

 

5. It was easy for me to get actively involved in the session 

o strongly agree 

o Agree 

o Neutral 

o Disagree 

o Strongly disagree 

 

 

6. I am clear about what skills are expected of me as a result of attending the 

program 

o strongly agree 

o Agree 

o Neutral 

o Disagree 

o Strongly disagree 

 

 

7. I anticipate that I will apply what I learned at my work 

o strongly agree 

o Agree 

o Neutral 

o Disagree 

o Strongly disagree 

 

 

8. I would recommend this program to other employees 

o strongly agree 

o Agree 

o Neutral 

o Disagree 

o Strongly disagree 

 

 

Comments: 

Comments: 

Comments: 

Comments: 
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Appendix B: Consent Form 

CONSENT FORM 
 
You are invited to take part in a research study of “Assessing Computer Literacy”. The 
researcher is inviting hospital employees, clinical and nonclinical to be in the study. This 
form is part of a process called “informed consent” to allow you to understand this study 
before deciding whether to take part. 
 
This study is being conducted by a researcher named Jolly Peter Isaac, who is a 
doctoral student at Walden University 
 
Background Information: 
The purpose of this study is to find the most accurate method of assessing computer 
literacy among hospital employees. The study will help to identify the training 
requirements of employees prior to Electronic Medical Record (EMR) implementation or 
any hospital IT application.  
 
 
Procedures: 
If you agree to be in this study, you will be asked to:  
 

 Take a self-assessment survey and an actual computer skills test of 20 
min duration at one time 

 
Voluntary Nature of the Study: 
This study is voluntary and if you chose to participate, your participation will be kept 
confidential and there will be no bias whether or not you choose to be in the study.  If 
you decide to join the study now, you can still change your mind during or after the 
study. You may stop at any time.  
 
Benefits and Risks of Being in the Study: 
You have the opportunity to help assess computer literacy within a hospital setting.  
Taking a test may be something which you are not very comfortable about. Taking the 
test is voluntary and you can withdraw at any time. I will share the results of the test with 
you alone and will not share individual results with your supervisor, manager or others 
within the organization. Knowing the results of the test, in the event it is not a favorable 
one may be disappointing to you. Again, the individual results will be shared only with 
you and remain confidential.  If the results are not as you expected, this could be an 
opportunity for you to further develop your skills through training or education.  
 
Payment/Compensation: 
Participation in this study is voluntary and there is no payment or compensation for 
participation. 
 
Privacy: 
Any information you provide will be kept confidential. The researcher will not use your 
personal information for any purposes outside of this research project. Also, the 
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researcher will not include your name or anything else that could identify you in the study 
reports. Data will be kept secure by password protected computer file. Data will be kept 
for a period of at least 5 years, as required by the university. 
 
Contacts and Questions: 
You may ask any questions you have now. Or if you have questions later, you may 
contact the researcher via mobile on 056 1074268 or e-mail jolly_petr@yahoo.com . If 
you want to talk privately about your rights as a participant, you can call Dr. Leilani 
Endicott. She is the Walden University representative who can discuss this with you. Her 
phone number is 001-612-312-1210. Walden University’s approval number for this study 
is 05-24-13-0187779 and it expires on May 23, 2014. 
 
The researcher will give you a copy of this form to keep.   
 
Statement of Consent: 
 
I have read the above information and I feel I understand the study well enough to make 
a decision about my involvement. By signing below, I understand that I am agreeing to 
the terms described above. 
 

 

Printed Name of Participant  

Date of consent  

Participant’s Signature  

Researcher’s Signature  

mailto:jolly_petr@yahoo.com
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Appendix C: Walden University IRB Approval 
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Appendix D: Letter of Cooperation from Organization 
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Appendix E: Self- Assessment of Basic Computer Skills 

Instruction: Read each question carefully and answer how you would rate yourself.  

 

Overall computer skills 
Beginner Proficient Expert 

   

 

Computer Skills 
     

How would you rate your ability in performing the following skills:      

General windows – I can Always Sometimes Not at all 

 Turn the computer on     

 Identify the 'End' key on the keyboard     

Identify the 'backspace' key on the keyboard     

Identify the ‘down arrow' key on the keyboard     

Click an object using the mouse     

Drag and drop objects using a mouse     

Log on to a computer using a password     

Shutdown' the computer using long method     

Microsoft Word - I can:   Always Sometimes Not at all 

Open  Microsoft word using the start menu     

Enter text in Microsoft word     

Save a document in a specified location     

Name a document before saving it     

Print a document     

Close Microsoft word application using long method     

Internet/ e-mail - I can:   Always Sometimes Not at all 

Launch  or open the Internet explorer     

Type a website address and access it     

Use Google and search the web for key words     

Read a topic which is hyperlinked     

Update the display of a current web page     

Go to web page that was previously displayed     

Open an unread e-mail on outlook     

Send a reply to an e-mail     

Copy a recipient on a e-mail      

Attach a document to an e-mail     

Excel Spread Sheet - I can  Always Sometimes Not at all 

Enter data in a cell on a Excel spread sheet     

Change the font size of a text in a selected cell     

 Fill color in a cell on the Excel spread sheet     

Add (sum) the data in two cells     
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Appendix F: Questions for Simulated Computer Skills Test 

# TASKS TOPIC

1 Turn on the computer.

2 Press the ‘End’ key.

3 Press the ‘Backspace’ key.

4 Press the ‘Down Arrow’ key.

5 Follow the mouse! Click where the mouse is standing.

6 Follow the mouse! Click where the mouse is standing.

7 Follow the mouse! Click where the mouse is standing.

8 Drag and drop the correct answer from column B to column A.

9 Log on to this computer with the password "riyad123".

10 For questions 10 -11: Shutdown the computer. (Do NOT use ALT-F4) 

11 For questions 10 -11: Shutdown the computer. (Do NOT use ALT-F4) 

12 For questions 12 - 13: Start Microsoft Word using the Start menu. (Do NOT use Windows Explorer.) 

13 For questions 12 - 13: Start Microsoft Word using the Start menu. (Do NOT use Windows Explorer.) 

14 For Questions 14 - 20:  Enter  the following text and press ENTER when done.

15 For Questions 14 - 20:  Enter  the following text and press ENTER when done.

16 For Questions 14 - 20:  Enter  the following text and press ENTER when done.

17 For Questions 14 - 20:  Enter  the following text and press ENTER when done.

18 For Questions 14 - 20:  Enter  the following text and press ENTER when done.

19 For Questions 14 - 20:  Enter  the following text and press ENTER when done.

20 For Questions 14 - 20:  Enter  the following text and press ENTER when done.

21 For Questions 21 - 23: Save the document in C:\Desktop\MyProject' directory.

22 For Questions 21 - 23: Save the document in C:\Desktop\MyProject' directory.

23 For Questions 21 - 23: Type 'Profile' in the file name field.

24 For Questions 24 - 26: Print this document.

25 For Questions 24 - 26: Print this document.

26 For Questions 24 - 26: Print this document.

27 For Questions 27- 28:  Close the ‘Microsoft Word’ application. (Use the long method for this task)

28 For Questions 27- 28:  Close the ‘Microsoft Word’ application. (Use the long method for this task)

29 Launch the ‘Internet Explorer’.

30 Go to the web site 'http://www.google.ae/'. (Do NOT use ALT-D.) (Do NOT use ALT-ENTER.)

31 Using google, search the Web with the keyword 'cardio exercise'. (Do NOT use ALT-D.)

32 Select the 'Top Cardio Exercises - The Best Cardio Exercise for Weight Loss' link.

33 Update the display of the current Web page.

34 Go to the Web page that was previously displayed. (Do NOT use ALT-LEFT ARROW.)

35 Open the unread email from ‘Lindsey   Richards’.

36 Send a reply to 'Lindsey Richards'.

37 Copy ‘Simi Mohandas’ in this email. 

38 Attach a document in this email. 

39 Go to C8 cell.

40 Type the number ‘10000’ in the selected cell. Press ENTER when done.

41 For Questions 41 - 42: Change the font size of the text in the selected cell to '11'.

42 For Questions 41 - 42: Change the font size of the text in the selected cell to '11'.

43 Change the cell color of ‘C11’ to Orange. Change the Fill Color of the selected cell to Standard Color Orange. 

44 Select the color Orange from the Standard Colors section.

45 Add 30,000 and 10,000.

Excel

General Windows

Word

Internet/Email
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